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Essential Instructions
Read this page before proceeding!

Brooks Instrument designs, manufactures and tests its products to meet many national and international
standards. Because these instruments are sophisticated technical products, you must properly install, use
and maintain them to ensure they continue to operate within their normal specifications. The following instruc-
tions must be adhered to and integrated into your safety program when installing, using and maintaining
Brooks Products.
• Read all instructions prior to installing, operating and servicing the product. If this instruction manual is not the correct

manual, please see back cover for local sales office contact information. Save this instruction manual for future reference.
• If you do not understand any of the instructions, contact your Brooks Instrument representative for clarification.
• Follow all warnings, cautions and instructions marked on and supplied with the product.
• Inform and educate your personnel in the proper installation, operation and maintenance of the product.
• Install your equipment as specified in the installation instructions of the appropriate instruction manual and per applicable

local and national codes. Connect all products to the proper electrical and pressure sources.
• To ensure proper performance, use qualified personnel to install, operate, update, program and maintain the product.
• When replacement parts are required, ensure that qualified people use replacement parts specified by Brooks Instrument.

Unauthorized parts and procedures can affect the product's performance and place the safe operation of your process at
risk. Look-alike substitutions may result in fire, electrical hazards or improper operation.

• Ensure that all equipment doors are closed and protective covers are in place, except when maintenance is being
performed by qualified persons, to prevent electrical shock and personal injury.

ESD (Electrostatic Discharge)

Handling Procedure:
1. Power to unit must be removed.
2. Personnel must be grounded, via a wrist strap or other safe, suitable means before any printed circuit card or other internal

device is installed, removed or adjusted.
3. Printed circuit cards must be transported in a conductive container. Boards must not be removed from protective enclosure

until immediately before installation. Removed boards must immediately be placed in protective container for transport,
storage or return to factory.

Comments
This instrument is not unique in its content of ESD (electrostatic discharge) sensitive components. Most modern electronic
designs contain components that utilize metal oxide technology (e.g. CMOS). Experience has proven that even small amounts of
static electricity can damage or destroy these devices. Damaged components, even though they appear to function properly,
exhibit early failure.
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Dear Customer,

The Brooks Service Suite is a Windows-based application that provides expanded control of Brooks Smart II Digital
Mass Flow Control (MFC) and Mass Flow Meter (MFM) devices for servicing tasks that include setup and configuration,
troubleshooting, and tuning and calibration.

We recommend that you read this manual in its entirety as this will enable efficient and proper use of the Brooks
Service Suite. Should you require any additional information concerning the Brooks Service Suite, please feel free to
contact your local Brooks Sales and Service Office or visit us on the web at www.brooksinstrument.com. We appreciate
this opportunity to service your fluid measurement and control requirements,and trust that we will be able to provide you
with further assistance in future.

Yours sincerely,

Brooks Instrument
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Section 1 Introduction

1.1 Description

The Brooks Service Suite provides expanded control of the Brooks Digital
Mass Flow Controller/Meters models SLA58xxS, SLAMfxxS and 48xx for
servicing tasks that include setup and configuration, troubleshooting,
tuning, and calibration.

Shown above Brooks Service Suite Main Window

Using an RS-232 connection between a personal computer (PC) and the
device’s service port, you can use the Service Suite to view, control, and
modify data such as:
• Flow
• Setpoint
• Analog input/output (I/O) configuration
• Valve tuning
• Device I/O calibrations
• Diagnostics
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Section 1 Introduction

1.2 Standard vs. Pro Version

There are two versions of the Brooks Service Suite application: Standard
and Pro. The Pro version includes all of the functions in the Standard
version, but also includes the ability to calibrate the device as described in
the Gas Calibration and Reporting (SLA58xxS and SLAMfxxS) and Gas
Calibration Correction (48xx) topics.
Note that the screen examples used throughout the manual are of the
Standard version, except for the gas calibration topics.

1.3 How to Use This Manual

It is recommended that you read this manual before installing or using the
Service Suite.
The manual is organized into eight sections:

Section 1 Introduction
Section 2 Theory of Operation
Section 3 Installation
Section 4 Basic Operations
Section 5 Control and Monitor
Section 6 Diagnostics
Section 7 Tuning
Section 8 Gas Calibration and Reporting (Pro Version Only)
Section 9 Gas Clibration Correction (Pro Version and 48xx Only)

NOTE:
For device troubleshooting information, refer to the device’s Installation and
Operations Manual.
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1.4 Integrated Help

The Brooks Service Suite features a searchable Help Database. This
database contains much of the information provided within this manual. To
access the Integrated Help feature, open the 'Help Menu' at the top of the
application and select 'Help' or press 'F1' from anywhere within the
program.
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Section 2 Theory of Operation

2.1 Theory of Operation

A typical mass flow measurement and control system consists of two
components:

• Mass flow meter. A mass flow meter incorporates a sensor that
measures the amount of mass flow and generates an electrical output
signal directly proportional to the mass flow rate.

• Control valve.
Mating a control valve with a mass flow meter provides a mass flow
controller (MFC).

Implementing a mass flow controller requires using the mass flow output
signal as one input and a user-supplied setpoint signal as another input
into a comparator circuit. These two signals are then compared and a
control signal is generated to operate the opening or closing of the valve.
The setpoint signal is, in effect, a request that the mass flow controller
maintain a fixed mass flow rate.

A setpoint signal can come in many forms. The Brooks MFC devices can
be digital or analog. The analog input/output (I/O) signals between the
mass flow device and the user’s control side are represented as a voltage
(0-5 Vdc or 1-5 Vdc) or current (0-20 mA or 4-20 mA). Alternately, a service
tool can be used to drive the setpoint digitally.

The Brooks Service Suite, which communicates with the device through an
RS-232 connection between the PC and the device’s service port
connector, uses a digital signal based on a proprietary protocol. The
Service Suite has two operating modes:

• Indicator, in which the Service Suite is reporting on the data sent to it
from the device which is being controlled by the normal setpoint source.

• Control, in which the Service Suite user specifies the setpoint, overriding
the normal setpoint source.

In either arrangement, the device will attempt to manage the opening and
closing of the control valve to maintain the amount of mass flow as
requested by the setpoint source.

Note that the Brooks Service Suite is meant to be used as a startup and
troubleshooting tool. It is not intended to be permanently connected to the
device in your application.
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Section 3 Installation

3.1 System Requirements

This section describes how to install the Service Suite application onto a
personal computer (PC), and how to connect the PC to the device.
The Brooks Service Suite application can be installed on a Windows PC
with the following requirements:

Component Minimum Requirements

Operating System Microsoft Windows 2000 (With SP4)
Microsoft Windows XP (With SP2)
Microsoft Windows Vista

COM Port One Serial or USB-to-Serial port adaptor
For the Pro version two serial or USB-to-
serial port adaptors are needed.

Security One spare USB port for security dongle.

3.2 Installing the Service Suite Application

To install the Service Suite application, load the Service Suite CD-ROM
into the drive. If the program installation shell does not appear
automatically, find the installation file in the root of the CD-ROM folder and
double click it to launch the installation wizard. Follow the installation
instructions in the wizard. In case no CD-ROM has been purchased,
download the BSS setup from the http://www.BrooksInstrument.com/bss
website and follow the instructions which are also available on this website.
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3.3 Connecting the Service Suite Dongle

The Service Suite requires that a dongle is connected to a USB port on the
PC, the picture below shows you how. You may install the application on as
many PCs are desired. However, the Service Suite will only operate on a
PC which has the dongle connected. The dongle comes in  two versions,
i.e. Standard and Pro.

USB Dongle

3.4 Connecting the PC to the Device

The following topics list the hardware requirements and describe the
procedure for connecting the PC running the Service Suite to the device’s
service port.

3.4.1 Hardware Requirements

Models SLA58xxS and SLAMfxxS
The following tools and cables are required to connect the PC serial port to
the device’s service port:

• RS-232 to TTL communications interface adapter.
• Standard RS-232 serial cable (between your PC’s serial

connector and the communications interface adapter).
• USB to RS-232 converter if no serial connector is available at the PC

This equipment may be purchased either with the Brooks Service Suite or
separately from Brooks Instrument. Contact the Factory or your local
representative for details.
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NOTE:
If the distance between the PC and the device is short enough, the RS-232
cable is not necessary. Plug the communications interface adapter directly
into the PC serial port.

• 3-wire communications cable (between the interface connector and the
device’s service port connector)

• Straight (flat blade) screwdriver
• 3/16-in. nut driver

The cable kit part number is: S778D023ZZZ

Model 48xx
The cables shown in the pictures below are required to connect a serial
port of a PC to the RS-232 port of the 48xx device. This RS-232 port on
the 48xxx device is available on the 15-pin D-connector.

• Straight (flat blade) screwdriver
• 3/16" nutdriver

Communications interface 

adapter

3-wire communications 

cable

Cable Length Part Number Connection
3m 124Z893ZZZ Thermal Device to Readout Device and PC
6m 124Z894ZZZ Thermal Device to Readout Device and PC
12m 124Z895ZZZ Thermal Device to Readout Device and PC

Cable Length Part Number Connection
3m 124Z905ZZZ Thermal Device to PC
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3.4.2 Connection Procedure (SL58xxS Series)

connect the PC to the device’s service port:
1. Turn off power to the device.
2. Remove the standard cable from the device’s 15-pin D-

connector.
3. Remove the screw at the center of the top cover.
4. Remove the cover.

5. Assemble the RS-232 serial cable, communications interface adapter,
and Service Suite 3-wire communications cable.

6. Connect the RS-232 serial cable to a serial port on your computer.

If the distance is short enough, you can connect the communications
interface adapter directly to the PC’s serial port, as shown below, and
do not need the RS-232 serial cable.

Black service port
connector

15-pin
D-Connector

Center cover
screw
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7. Connect the 3-wire communications cable to the device’s service port,
which is the black connector located behind the D-connector. Align the
communications cable’s 5-pin connector with the black wire towards
the center of the device (towards the LEDs), as shown in the following
illustration.

Service port
connector attached
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8. Reconnect the standard cable to the device’s D-connector.
This connection is used to apply power and the analog setpoint to the
device while using the Service Suite.

9. Turn on power to the device.
10. Verify that the device initializes properly, as indicated by the Status

LED being solid green.
You are now ready to use the Service Suite.

3.4.3 Connection Procedure (SLMfxxS Series)

To connect the PC to the device’s service port:

1. Turn off power to the device.

2. Loosen the four (4) top cover screws using a ¼” allen wrench.

3. Remove the top cover.

Service port
connector

Top cover
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4. Assemble the RS-232 serial cable, communications interface adapter,
and Service Suite 3-wire communications cable.

5. Connect the RS-232 serial cable to a serial port on your computer.

If the distance is short enough, you can connect the communications
interface adapter directly to the PC’s serial port, as shown below, and do
not need the RS-232 serial cable.

6. Connect the 3-wire communications cable to the device’s service port,
which is the 5-pin connector (labeled SERVICE PORT) located to the
rear of the device next to the ALARM and STATUS LEDs.  The black
wire should be located next to the SERVICE PORT pin 1 identifier
(towards the ALARM LED) as shown in the following illustration.

7. Turn on power to the device.

8. Verify that the device initializes properly, as indicated by the STATUS
LED being solid green.

You are now ready to use the Service Suite.

Service port
connector attached
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3.4.4 Connection Procedure (SL79xxS Series)

To connect the PC to the device’s service port:

1. Turn off power to the device.

2. Remove the screw at the center of the top cover.

3. Remove the detachable portion of the top cover.

4. Assemble the RS-232 serial cable, communications interface adapter,
and Service Suite 3-wire communications cable.

5. Connect the RS-232 serial cable to a serial port on your computer.

Service port
connector

Top cover

Top cover
screw
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If the distance is short enough, you can connect the communications
interface adapter directly to the PC’s serial port, as shown below, and do
not need the RS-232 serial cable.

6. Connect the 3-wire communications cable to the device’s service port,
which is the 5-pin connector (labeled SERVICE PORT) located to the
rear of the device next to the ALARM and STATUS LEDs.  The black
wire should be located towards the center of the device (towards the
LEDs), as shown in the following illustration.

Service port
connector attached

7. Turn on power to the device.

8. Verify that the device initializes properly, as indicated by the STATUS
LED being solid green.
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3.4.5 Connection Procedure (48xx)

To connect the PC to the device’s RS-232 port:

1. Connect the "THERMAL SIDE" of the cable mentioned in the Hardware
Requirements to the device.

2. Connect the "READ OUT SIDE" of the cable to one of the channels of
a 0254/0152/0154 Read Out.

3. Connect the "P.C. SIDE" of the cable to one of the serial ports of the
PC, if needed use a USB/RS-232 converter in case there is no serial port
available on the PC.

You are now ready to use the Service Suite.
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3.4.6 Disconnecting the PC from the Device (SL58xxS Series)

When you are done using the Service Suite, you should disconnect the PC
from the device and reinstall the device’s cover.

To disconnect the PC from the device’s service port:

1. Exit from the Service Suite.

2. Turn off power to the device.

3. Disconnect the standard cable and the 3-wire communications cable
from the device.

4. Disconnect the RS-232 serial cable (or interface adapter) from your PC.

5. Place the cover onto the device, and reattach it using the screw at the
center of the top cover.

6. Reconnect the standard cable to the device’s 15-pin D-connector.

You can now reapply power to the device and begin using it in a process
application.
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3.4.7 Disconnecting the PC from the Device (SLMfxxS Series)

When you are done using the Service Suite, you should disconnect the PC
from the device and reinstall the device’s cover.

To disconnect the PC from the device’s service port:

1. Exit from the Service Suite.

2. Turn off power to the device.

3. Disconnect the 3-wire communications cable from the device.

4. Disconnect the RS-232 serial cable (or interface adapter) from your PC.

5. Place the top cover onto the device and reattach it by tightening the
four (4) allen head socket screws.

You can now reapply power to the device and begin using it in a process
application.
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3.4.8 Disconnecting the PC from the Device (SL79xxS Series)

When you are done using the Service Suite, you should disconnect the PC
from the device and reinstall the device’s cover.

To disconnect the PC from the device’s service port:

1. Exit from the Service Suite.

2. Turn off power to the device.

3. Disconnect the 3-wire communications cable from the device.

4. Disconnect the RS-232 serial cable (or interface adapter) from your
PC.

5. Place the detachable top cover back onto the device by inserting the
alignment pegs located at the bottom of the detachable cover into their
respective mating holes on the stationary portion of the top cover.

6. Insert and tighten the top cover screw.

You can now reapply power to the device and begin using it in a process
application.
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3.4.9 Disconnecting the PC from the Device (48xx)

To disconnect the PC from the device’s RS-232 port:

1. Exit from the Service Suite.

2. Turn off power to the device.

3. Disconnect the "P.C. Side" of the cable

4. Disconnect the "THERMAL SIDE" and "READ OUT SIDE" of the cable

5. Reconnect the standard cable to the device's 15-oin D-connector

You can now reapply power to the device and begin using it in a process
application.
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3.4.10 Device D-Connector Pin-Outs

The Smart II pin-outs are listed below.

       

1

15

8

9

Pin No. Function
1 Setpoint Return, Common Input (-)
2 Flow Signal, 0(1) -5 volt, Output (+)
3 TTL Alarm open collector, Output (+)
4 Flow Signal,0(4) -20 mA, Output (+)
5 Power Supply, +13.5 to +27 Vdc (+)
6 Not Connected
7 Setpoint,0(4) -20 mA, Input (+)
8 Setpoint, 0(1) -5 volt, Input (+)
9 Power Supply, Common (-)
10 Flow Signal,Common, Output, (-)
11 Reference, +5 Vdc, Output (+)
12 Valve Override, Input
13 Calibration Select, Input
14 RS-485 Comm B (-)
15 RS-485 Comm A (+)

Terminal diagrams for the Mf models

Analog

DeviceNet

FOUNDATION Fieldbus
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3.4.11 48xx 15-pin D-Sub Connector Pin Out
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4.1 Basic Operations

This section describes the Service Suite’s basic operations, including:

• Service Suite conventions

• Starting the tool and opening a new session

• Setting the options to determine what variables will be displayed in the
Graph window and how they will be displayed

• Specify whether the setpoint will be controlled from the Service Suite or
by an external source

• Controlling different aspects of how the trend graph is displayed in the
Graph window

• Capturing the current state of the trend graph to the clipboard or a file,
and/or by printing it to a hard copy

• Changing Report Template Preferences allowing the user to customize
the logo and address information on the Calibration Report

• Saving and restoring a device configuration file

• Closing the session and exiting the tool

• Import Database functionality which allows the user to retain device and
calibration related data used on the Calibration Report, when
performing an upgrade of the Service Suite application

4.1.1 Service Suite Conventions

The Service Suite was designed to remain consistent with regard to how
the user interacts with the application across all functions and features.

The following text field conventions apply throughout the application:

• Text fields with a black background display a read-only parameter.

• Text fields with a white background are editable.

• Text fields will be stored when the focus changes to another field by
means of a mouse click or the TAB. The text field will change color to
indicate that the new value has been stored.

• Text fields which are indicated with a red asterisk need to be filled with
a valid value.
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4.2 Starting the Service Suite and Opening a New Session

To start the Service Suite and open a new session:

1. Select the Brooks Service Suite from your Start menu, or double-click
its application file. The main window displays, with no session open.

2. To open a new session, open the File menu and select New Session.

The Open Session dialog box displays.
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3. From the drop-down lists, select the device type and the Comm port to
which the Service Suite cable is connected, then click OK.

The Control & Monitor and Graph windows open, and the Graph
window begins showing the trend data that is being read from the
device.
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4.3 Graph Window Elements

Figure 4-1 indicates the major elements of the Graph window.

Current Setpoint

value

 Setpoint Control 

Source options

Trend Graph

Variable data; color of 

value matches trend line

color

Trend lines of selected

variable data, indicated

by color

Trend Graph

controls

Full scale flow to 

which the device

was calibrated

Total flow volume as  

measured by the device

X-axis, indicating elapsed time

window since start of session

Y-axis, indicating percent

of variable data relative

to upper/lower range settings, 

as defined in the main window options

Figure 4-1 Graph Window Elements

4.4 Setting the Graph Window Options

To set the Graph window options, open the Tools menu and select
Trend Graph Options. The Options window displays. From this window,
you can perform the functions described in Table 4-1.
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Table 4-1 Options Window Functions

Function Description
Modify the current settings You can modify the options settings on

any of the three tabs. The options on the
three tabs, and which elements on the
Trend Graph window they control, are
illustrated in Figures 4-2 through 4-4.

Cancel your setting changes Click the Cancel button.

Save your setting changes Click the Apply button.

NOTE:
Changes that you make to the option settings become the default values
the next time a session is opened.

Figure 4-2 Process Variable Options
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Figure 4-3 Units of Measure Options

Resolution
The amount of decimal digits shown for volumetric and mass flow process
variable values in the graph window depend on the selected resolution and
the full scale value. The resolution can be 2.5, 3.5 and 4.5 Digits.
Dependent on the full scale value the .5 digit means that you’ll get 1 digit
more to display the value if the full scale value starts with 1, e.g. full scale
value is 100 you’ll get 3, 4 or 5 digits for displaying the process variable.
This will lead to 0, 1 or 2 decimal digits for resolution set to 2.5, 3.5 or 4.5
digits respectively. If the full scale value starts with e.g. a 2, you’ll get 2, 3
and 4 digits to display the process variable value in case the resolution is
set to 2.5, 3.5 or 4.5 digits respectively. This will lead to 0, 0 and 1 decimal
digits to display. In case e.g. a 2.5 digit resolution is selected and the full
scale value is 200, the volumetric and mass flow process variables will only
have 2 digits available for displaying a value. This means that value higher
than 99 can not be shown, the field will indicate ‘#RES’, see picture (‘graph
window RES.bmp’) below.

To solve this issue the resolution needs to be increased or another unit
needs to be chosen.
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Y-Axis Scale values
determine upper and lower

percentage values
of full scale flow
along the Y-axis

X-Axis Scroll Method determines how trend graph
will advance over time:
-Smooth (continuously), or
-Page (in time window increments; for example, every 30 seconds)

Select the option to assume manual control
of the Y-axis by entering values in the
Y-axis Min Scale and Max Scale fields.
When deselected, the Y-axis scaling
changes dynamically with changes
in signal magnitude.*

X-Axis Window
determines the time
window displayed
along the X-axis

Figure 4-4 Trend Graph Options

* With the User Adjust option selected, trend graphs whose values exceed the value
in the Y-axis Max Scale field will not be viewable in the trend graph. You could use
the scroll tool to scroll up the Y-axis to view the graph, but scrolled views will snap
back to standard view once you release the mouse button.



4-8

Installation and Operation Manual
X-SW-BSS-eng

Part Number: 541B033AAG
September, 2013Brooks® Service SuiteTM

Section 4 Basic Operations

Tuning Step
The following window will allow the user to select the step which is used for
increasing or decreasing the following data fields using the up and down
buttons:
• Valve Tuning, position of the valve in case manual mode is selected.
• PID Control in response tuning window.
• Flow Sensor in response tuning window.
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4.5 Choosing the Input Source for the Device - Service Suite or External

By default, a session opens with the external source providing the setpoint
input to the device. In this mode, data in the Service Suite’s Graph window
indicates what the device is currently reporting as its setpoint.

However, you can control the setpoint directly from the Service Suite by
selecting the Brooks Service Suite option in the Source Control panel,
then entering a value in the Setpoint field. Figure 4-1 on p. 4-4 calls out
these controls.

Upon exiting the application, setpoint source control is automatically set to
External.

4.6 Trend Graph Functions

The following topics cover the functions that you can perform on the trend
graph.

4.6.1 Trend Graph Toolbar Functions

Table 4-2 summarizes the Trend Graph’s toolbar functions.
The following topics provide more detail about each of the Trend Graph
toolbar functions.
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Table 4-2 Summary of Trend Graph Toolbar Functions

Function Description

Starts variable data trending, if it has been stopped.

Stops variable data trending.

Scroll up and down the Y-axis, or back and forth across the X-axis.
(Y-axis User Adjust option must be selected; refer to Figure 4-4 on
p. 4-7.)

Zoom in and out of a selected axis. (Y-axis User Adjust option must
be selected; refer to Figure 4-4 on p. 4-7.)

Zoom in and out of both axes simultaneously.

Zoom in on a region of the trend graph.

View the X- and Y-axes values at a given point in time the trend
graph.

Change the graph’s display properties. It is recommended that you
use the default settings.

Copy the trend graph to the clipboard.

Save the trend graph as a file.

Print the trend graph.



4-11

Installation and Operation Manual
X-SW-BSS-eng
Part Number: 541B033AAG
September, 2013 Brooks® Service SuiteTM

Section 4 Basic Operations

4.6.2 Pausing and Starting Trending

You can pause the real-time updating of trending data at any time. For
example, you may want to analyze the current window of data for
troubleshooting. Pausing the trend graph freezes the data as it is currently
displayed.

To pause trending, click the  button in the Trend Graph toolbar.  With
trending paused, you can continue to use the other toolbar functions on the
portion of the graph that is displayed.
By default, when trending is paused, the data from the device is not
tracked until trending is restarted. However, you can enable data tracking
with trending paused, and thus pick up the trending graph where it left off
when paused when you decide to restart trending.
To enable data tracking with trending paused, move the pointer over
the X or Y axis area and right-click. From the pop-up menu that displays,
select the Tracking Enabled option.

To restart trending, click the  button. When you restart trending, the
trend graph will jump to display the most recently collected data. To see
data collected while the trend graph was stopped, use the X-axis Scroll
Tool, covered in the next topic.

4.6.3 Scrolling a Graph Axis

The Scrolling tool allows you to scroll up and down the Y-axis, or back and
forth across the X-axis. This can be helpful in seeing other areas of the
trend graph (for example, if you have zoomed in on it, or if you want to see
previous portions of the trend graph).

To scroll on an axis, click the  button in the Trend Graph toolbar and
move the pointer over the axis on which you want to scroll. The pointer
turns into a pointing hand. Click and drag in the direction you want to scroll.
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4.6.4 Zooming on a Single Graph Axis

The Zooming on a Single Axis tool allows you to zoom on the X- or Y-axis.

To zoom on an axis, click the  button in the Trend Graph toolbar and
move the pointer over the axis on which you want to scroll. The pointer
turns into a double-headed arrow, pointing in the directions relative to the
axis it is over. Click and drag in the direction you want to zoom.

Before Y-axis scrolling After Y-axis scrolling

NOTE:
The Y-axis User Adjust option must be selected for this feature to work;
refer to Figure 4-4 on p. 4-7.

Before X-axis zooming After X-axis zooming

NOTE:
The Y-axis User Adjust option must be selected for this feature to work;
refer to Figure 4-4 on p. 4-7.
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4.6.5 Zooming on Both Graph Axes

The Zooming on Both Axes tool allows you to zoom on the X- and Y-axes
at the same time.

To zoom on both axes simultaneously, click one of the  buttons
in the Trend Graph toolbar. The trend graph scrolling is paused. Click and
drag on the axes to scroll them to view the portion of the graph you

zoomed in on (if you zoomed in). Click the  button to restart graphing.
After clicking play, axes return to default zoom factor.

Before zooming in on both axes After zooming in on both axes
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4.6.6 Zooming on a Region of the Graph

The Zooming on a Region tool allows you to zoom on a region on the
trending graph, adjusting the X- and Y-axes scales accordingly.

To zoom on a region of the trend graph, click the  button in the
Trend Graph toolbar and move the pointer over the trend graph. The
pointer turns into an arrow with a box. Click and drag to draw a box around
the region on which you want to zoom, then release the mouse button.
Graphing pauses like before to allow you to examine the zoomed area. You
can click and drag to scroll through the axes.

With region to zoom selected in box After region was zoomed on

NOTE:
When you release the mouse button, the trend graph freezes on the

bounded region. You have to click the  button to resume trending.
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4.6.7 Displaying the Entire Trend Graph

You can display the entire trend graph in the graph area.
To display the entire trend graph, move the pointer over the X or Y axis
area and right-click. From the pop-up menu that displays, select the Zoom
to Fit option.

To return to the standard view of the trend graph, deselect the Zoom to Fit
option.

4.6.8 Displaying X and Y Values at a Particular Point

The Values tool allows you to select a point along the Mass Flow trending
graph and display the corresponding X- and Y-axis values at that point.

To display the exact X and Y values of the trend graph, click the 
button in the Trend Graph toolbar and move the pointer over the trend
graph. The pointer turns into pointing finger over a colored vertical
line—the cursor. The X,Y values for the current cursor position are
displayed. As you click and drag the cursor across the trend graph, the X,Y
values dynamically update.

X,Y values at current cursor position
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If you right-click on the cursor, a pop-up menu displays, allowing you to
select from several options that control the cursor’s attributes. These
options are described in Table 4-3.

Option Description

Channel Allows you choose the channel to which the cursor is
attached. The channels correspond to the variables
(Mass Flow, Setpoint, and so on).

Style Allows you to choose the measurement being made:

• Value X-Y. Cursor is a single line.

• Value X. Cursor is a single line.

• Value Y. Cursor is a single line.

• Period. Cursor is two vertical lines connected
with a dotted line, showing the time/frequency
between the lines.

• Peak-Peak. Cursor is two horizontal lines
connected by a dotted line showing the
percentage difference between the lines (because
Y-axis is in percent).

• Frequency. Cursor is two vertical lines connected
with a dotted line, showing the time/frequency
between the lines.

For Styles whose cursor is two lines, you can drag
each line separately to make measurements.

Options>Use Channel Color If selected (the default), the cursor is the color
related to the variable. If not selected, the cursor is
yellow.

Options>Hide Hint on Release If selected, the values associated with the cursor are
shown only while the left mouse button is held down.

Flip Alignment Enabled only with single-line cursor styles. If
selected, moves the values displayed to the opposite
side of the vertical line.

Edit For Brooks internal use only.

Table 4-3 Trend Graph Cursor Options
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4.6.9 Copying the Graph to the Clipboard

You can copy the current state of the trend graph to the clipboard, for
pasting into another Windows application.

To copy the current state of the trend graph to the clipboard, click the

 button in the Trend Graph toolbar. The trend graph is copied to the
clipboard. A sample of the trend graph pasted into a document is shown
below.
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4.6.10 Saving the Graph to a File

You can save the current state of the trend graph to a graphic file.

To save the current state of the trend graph to a graphic file, click the

 button in the Trend Graph toolbar. The Save As dialog box displays.

Navigate to the desired directory and enter a name for the file. You can
also specify the graphic format—Bitmap (.bmp), Enhanced Metafile (.emf),
or JPEG (.jpg)—from the Save as type drop-down list. Click the Save
button to save the file.

4.6.11 Printing the Graph

You can print the current state of the trend graph to a printer.

To print the current state of the trend graph, click the  button in the
Trend Graph toolbar. The standard Windows Print dialog box displays.
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4.7 Status Bar

The Status Bar, at the bottom of the Service Suite main window, indicates
the status of alarms and warnings, the valve, and the communications
interface between the application and the device.

4.8 Preferences, Report Template (Not supported by 48xx)

It’s possible to change the default Brooks addresses and logo on the
calibration report by selecting the ‘Custom’ radio button.
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4.9 Saving the Current Device Configuration  (Not supported by 48xx)

To save the current device configuration settings and calibration
data, open the File menu and choose Save Device Configuration. The
Save Device Configuration File window displays.

To accept the default file name and directory, click the Save button. You
can also change the file path and name by editing the file name field entry,
or by clicking the Browse button to display a Save As dialog box.
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4.10 Import Database (Not supported by 48xx)

This version of the Brooks Service Suite supports the Import Database
functionality in order not to loose any product and calibration related data
used on the Calibration Report when performing an upgrade of the Brooks
Service Suite application. In case the version of the Brooks Service Suite
application you’re going to uninstall is 2.0.1 or older, you’ll have to perform
some manual copy actions. If the version of the Brooks Service Suite
application you’re going to uninstall is 2.0.2 or newer the database will be
stored in a backup folder called ‘BSS Backup’ ($programfiles-> Brooks
Instrument->BSS Backup). In the newer version of the Brooks Service
Suite you’ll have to execute the ‘Import Database’ functionality and select
this backup copy to restore the database. Note that the Import Database
functionality is only available in case the session is closed.
Manually backup database:
• Create a backup folder called ‘BSS Backup’ in the Brooks Instrument

Program Files folder ($programfiles->Brooks Instrument->BSS
Backup).

• Copy the ‘UserEntry.mdb’ file available in the ‘Brooks Service Suite’
folder ($programfiles->Brooks Instrument->BSS Backup->Brooks
Service Suite) to this newly created ‘BSS Backup’ folder, make sure
hidden files and operating files are visible.
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4.11 Restoring a Saved Device Configuration  (Not supported by 48xx)

You can restore any previously saved device configuration and calibration
data set.
To restore a saved current device configuration, open the File menu
and choose Restore Device Configuration. The Restore Device
Configuration File window displays.

You can enter the file path and name in the file name field or, to select the
desired file, click the Browse button to display an Open dialog box. Once
you have specified the file path and name, click the Restore button to
restore the configuration from that file.

4.12 Closing the Session and Exiting the Service Suite

To close the current session and exit the Service Suite, open the File
menu and choose Exit, or click the window’s close button (at the upper
right corner).

Alternately, if you just want to close the session but not the application,
open the File menu and choose Close Session. This feature is useful
when switching the application from one device to another.
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5.1 Control and Monitor

This section describes how to:
• View device information

• Select a calibration data set

• Set the Totalizer function, which keeps a running total of the amount of
gas or fluid that has flowed through the device

• Override the normal operation of the device’s valve

5.1.1 Viewing Device Information

To view device information, open the Actions menu and choose
Control and Monitor. The Control & Monitor dialog box opens. Click the
Device Info tab.

The device information parameters are read-only.

Device info for Models SLA58xxS and SLAmFxxS Device info for Models 48XX
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5.2 Selecting a Calibration Data Set

You can switch between up to 10 calibration data sets, according to the
current application of the device. These data sets are created as part of the
Service Suite’s Calibration function (available in the Pro version). Each
calibration data set includes a unique set of calibration and tuning
parameters, to be used with a specific application of the device.
The service person at the site who is performing calibrations should keep a
record listing to which application each calibration data set number applies.
To select a calibration data set, open the Actions menu and choose
Control and Monitor. The Control & Monitor dialog box opens. Click the
Calibration Data Set tab.

Select a data set from the Selected Flow Calibration Record drop-down
list. Key descriptive parameters for each data set are displayed in the
other, read-only fields.
In case the Analog Function Select Enable check box is checked, Pin 13
of the 15-pin D-sub connector will be used to determine the selected flow
calibration record. In case this check box is not checked, the flow
calibration records can be selected using the Selected Flow Calibration
Record drop down list.

NOTE:
Setting pin 13 (Calibration Select Input) will override the selected flow
calibration record as set by the Service Suite.
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5.3 Setting the Totalizer Control

The Totalizer function keeps a running total of the amount of gas or fluid
that has flowed through the device since the Totalizer function was turned
on or reset.

To set the Totalizer Control, open the Actions menu and choose Control
and Monitor. The Control & Monitor dialog box opens. Click the Totalizer
Control tab.

Use the Flow Totalizer Control options to turn the Totalizer function on or
off, or to reset it.

The dialog box also shows you the following read-only information:

• How frequently the nonvolatile flow totalizer is updated

• The current total flow

• The total flow as stored in non-volatile memory. This value is updated
by the rate in the Flow Totalizer Update Time field.
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5.4 Using the Valve Control Function

The Service Suite’s Valve Control function allows you to have the valve
track setpoint (normal mode), completely open or close the valve, or
manually open the valve at a percentage between 0 and 100%.

To control the valve, open the Actions menu and choose Control and
Monitor. The Control & Monitor dialog box opens. Click the Valve Control
tab.

Set the valve position by:

• Clicking one of the preset value buttons—Normal (tracks setpoint),
Close, or Open.

or

• Clicking the Manual button and entering the value in the Valve
Position field, then pressing the Enter key.

The Manual mode of operation is sometimes useful for diagnostic
purposes. The valve must be set to Normal mode for the device to function
properly.
If the device also supports an analog Valve Override input (e.g. Model
SLA58xxS) then this analog Valve Override will take precedence over the
digital Valve Override. In case the "Valve State" in this window is not in line
with the "Valve Status" in the status bar then the analog Valve Override is
active. Changing the Valve Control within the Service Suite will not have
any effect in this case.
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5.4.1 Using Pin 12 to Control the Valve Override

You can also use pin 12 of the device’s 15-pin D-connector to override
normal valve operation:

• Grounding pin 12 causes the device to close the valve.

• Applying a voltage from 5–24 V nominal causes the device to open the
valve. Do not exceed 25 V.

• Leaving pin 12 open (unconnected) causes the valve to operate
normally (device tracks setpoint).

Note that an input signal to pin 12 takes precedence over the Service
Suite’s Valve Override function. If the device is in VOR Open or VOR
Closed due to the signal at pin 12, then in the Service Suite:

• The status message “Analog Override Active” will appear at the top of
the Valve Override Control window.

• The Valve Override Control buttons will not change.

• The Valve Status in the Status Bar indicates the actual state of the
device.

• The Valve State field in the Valve Control tab also indicates the actual
state of the device.
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6.1 Diagnostics

This section describes how to:

• Test that the device is correctly reading its input (setpoint), and correctly
setting its output

• View and set S-Protocol configuration parameters

• Reset the device

• View the current state of the device’s warning/alarm conditions and
diagnostic results

• Data Log

6.1.1 Testing the Analog Output

You can use the diagnostic Test Analog Output function to verify that the
device is correctly setting its analog output.
Prior to using the Service Suite to test the output, you must connect a
digital multimeter (DMM) to the output signal to measure the true output
reading. Figures 6-1 and 6-2 show how to set up the DMM for the available
output type configurations.
Note that all of the D-connector pin-outs are listed in “3.5 Device
D-Connector Pin-Outs” on p. 3-8.

Figure 6-1 Setup for Testing Output Voltage

Power Supply

13 - 30 Vdc

DMM

(Precision 

Voltmeter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

Pin 5

Pin 10

Pin 2

Pin 9

+

_

+

_
DB15 Connector

8

9
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Power Supply

13.5 - 27 Vdc

DMM

(Precision 

Current Meter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. R ≤ 500 Ω for supply ≤ 16 Vdc. R ≤ 380 Ω for supply ≥ 16 Vdc.

3. Tie cable shields to ground at one end only.

Pin 5

Pin 10

Pin 4

R

Pin 9

+

_

+

_
DB15 Connector

8

9

To test an output:

1. Open the Actions menu and choose Service Actions>Diagnose.

The Diagnose dialog box opens. Go to the Test Analog Output tab. The
device’s output signal type is automatically chosen and cannot be
changed from this dialog box.

NOTE:
For an explanation of the Output Configuration parameters, refer to
Table 7-1 on p. 7-17. To change the output configuration type or adjust the
output behavior options, refer to “7.4.1 Viewing the Output Signal Setting
and Parameters” on p. 7-17.

Figure 6-2 Setup for Testing Output Current

500380
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2. Change the device’s output value by:

• Clicking one of the preset value buttons in the Test panel, or

• Clicking the User button, which makes the Current Value field editable,
and entering a value in the field, then pressing the Enter key.

Regardless of which method you choose, the selected value is shown in
the Current Value field at the bottom of the window. This is the value at
which the Service Suite is telling the device to set its output.

3. Verify whether the DMM shows the same value as set using the
Service Suite.

4. Try a few additional values to check that the output is correct.
If the DMM reading does not match the value being set in the Test
Analog Output tab, the device’s output may need to be calibrated. Refer
to “7.4.2 Calibrating the Output Signal” on p. 7-18.

6.2 Testing the Setpoint Input

You can use the diagnostic Test Setpoint Input function to verify that the
device is correctly reading its input (setpoint) value.

Prior to using the Service Suite to test the setpoint, you must connect a
DMM to the device’s setpoint signal to measure the true reading.
Figures 6-3 and 6-4 show how to set up the DMM for the available input
types.

Note that all of the D-connector pin-outs are listed in “3.5 Device
D-Connector Pin-Outs” on p. 3-8.
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Power Supply

13.5 - 27 Vdc

Precision 

Voltage 

Source

DMM

(Precision 

Voltmeter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

Pin 5

Pin 8

Pin 1

Pin 9

+

_

+

_

+

_
DB15 Connector

8

9

Power Supply

13.5 - 27 Vdc

Precision 

Current 

Source

DMM

(Precision 

Current Meter)1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

3. Input impedance = 125 Ω.

4. Absolute maximum input (without change): 25 mA.

Pin 5

Pin 7

Pin 1

Pin 9

+

_

+

_

+

_
DB15 Connector

8

9

NOTE:
When the analog input is configured for digital mode, the setpoint is
controlled via digital communications and the signal on the analog input is
ignored. To test the analog input, the analog input configuration must be
set to a mode other than digital. The analog input configuration can be
changed from the Trend Graph window using the Control Source function.

Figure 6-3 Setup for Testing Voltage Setpoint

Figure 6-4 Setup for Testing Current Setpoint
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To test the device’s setpoint reading:

1. Open the Actions menu and choose Service Actions>Diagnose.

The Diagnose dialog box opens. Go to the Test Setpoint Input tab. The
device’s input signal type is automatically chosen.

The device’s current reading of the setpoint is displayed in the Measured
Input field.

NOTE:
For an explanation of the Current Configuration parameters, refer to
Table 7-2 on p. 7-22. To change the current configuration type or adjust the
output behavior options, refer to “7.5.1 Changing the Input Signal Setting
and Parameters” on p. 7-21.

2. Verify whether the DMM shows the same value as that shown for the
device value in the Measured Input field.

NOTE:
Input signals below the level shown in the Low Input Cutoff field will be
shown as 0 V or 4 mA.

3. Try a few additional setpoint values by changing the setpoint from the
input source, and verify that the value in the Measured Input field
reflects those changes.
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If the DMM reading does not match the value in the Measured Input field,
the device’s setpoint may need to be calibrated. Refer to “7.5.2 Calibrating
the Device Input (Setpoint)” on p. 7-22.

6.3 Viewing and Setting S-Protocol Parameters

The S-Protocol is an RS-485 based form of digital communication used by
an external source to control the device. Brooks MFC/MFM models which
support the S-Protocol are the SLA58xxS and SLAMfxxS. The protocol
may be used in a standalone or multi-drop configuration to perform basic
operations, such as setting the setpoint, reading flow, setting valve
override, setting units of measure, and managing alarms.

The S-Protocol function in the Service Suite allows you to set the device’s
S-Protocol configuration parameters.

To set S-Protocol configuration parameters, open the Actions menu
and choose Service Actions>Diagnose. The Diagnose dialog box opens.
Go to the S-Protocol tab.
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Table 6-1 describes the S-Protocol configuration parameters.

NOTE:
The Service Suite does not use the S-protocol to communicate with the
device. Access to the S-protocol parameters provided by the Service Suite
may be used only to determine or configure this protocol’s communication
settings.

Table 6-1 S-Protocol Configuration Parameters

Parameter Description

Date 32-bit integer value that represents the date value
that is written and read via the S-Protocol
Communication port. The Date value can be
utilized by the user for any purpose and has no
affect on the device.

Descriptor A 16-character string that the user can use to
describe the device. This parameter can be
written and read via the S-Protocol
Communication port.

Device Type Read Only. Will always be 5 for Smart II devices.

Data Rate Sets the data rate for serial communications of
the S-Protocol port. Must be 1200, 2400, 4800,
9600, 19200, or 38400.

User Ref. Temp. Reference Temperature (in degrees K) for which
flow is to be reported if the user-specified
Standard Reference Conditions. (See S-protocol
manual for more details.)

Manuf. ID Read Only. Always 10 for Brooks Instrument
devices.

Message A 32-character string that the user can use for
any desired purpose. This parameter can be
written and read via the S-Protocol
Communication port.

Tag Name 8-character string used to identify the device on
the network to obtain the device’s long address.

Unique ID No. A 32-bit integer in the range of 0 to 16777216.
This value is assigned by Brooks and must be
unique for all Smart II devices.

User Ref. Pressure Reference Pressure (mbar) for which flow is to be
reported if the user-specified Standard Reference
Conditions. (See S-protocol manual for more
details.)

Number of Preambles The number of Preamble characters that the
device will transmit as part of every response
message on the S-Protocol communications port.



6-8

Installation and Operation Manual
X-SW-BSS-eng

Part Number: 541B033AAG
September, 2013Brooks® Service SuiteTM

Section 6 Diagnostics
(Not supported by 48xx)

Table 6-1 S-Protocol Configuration Parameters (cont.)

Parameter Description

Polling Address Short address of the device, must be in the range
0 to 15. This address can be used to access the
long address from the device.

Primary Alarm Behavior Read Only. Specifies how the Flow Output will
behave if an alarm is active. Settings are: Track,
Hold Last, Upscale, Downscale.

Flow Units Defines the UOM that flow is to be reported in on
the S-Protocol Communications Port. (The
meaning of this 8-bit code is defined in the
S-Protocol manual).

Temp. Units Defines the UOM that temperature is to be
reported in on the S-Protocol Communications
Port. (The meaning of this 8-bit code is defined in
the S-Protocol manual.)

NOTE:
Brooks Instrument provides an S-Protocol manual that describes the
operation of the S-Protocol for Smart II devices. Contact the Factory or
your local sales representative for more information.
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6.4 Rebooting the Device

The Software Suite’s Device Reboot function allows you to Reboot the
device, which is similar to powering the device off and on.

To reboot the device, open the Actions menu and choose Service
Actions>Diagnose. The Diagnose dialog box opens. Go to the Device
Reboot tab and click the Reboot button.
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6.5 Checking the Warning, Alarm and Diagnostic Status

The Service Tool monitors the warning or alarm status for all of the alarms
and warnings that the device may potentially indicate. The Service Tool
also reports on the status of the device diagnostics, which run
continuously.
To view the current state of alarm/warning conditions and diagnostic
results, open the Actions menu and choose Service Actions>Diagnose.
The Diagnose dialog box opens. Go to the Alarm Status tab.
The Alarm Status tab includes three subtabs, explained in the following
topics.

6.5.1 Checking the Alarm/Warning Status in the Alarms/Warnings Tab

The Alarm/Warning Status subtab lists each of the alarm/warning
conditions that the device may indicate and its respective flash codes (the
code that is flashed on the device’s Alarm LED).
NOTE:
For information on configuring the alarm/warning settings, refer to “7.6
Configuring Alarm Settings” on p. 7-25. For a description of the various
conditions for which alarms/warnings that are available, refer to Table 7-3
on p. 7-26.
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• If an alarm condition is detected, its code field will flash red and the Alarm
Status indicator in the Status Bar of the main window will flash.
• If a warning condition is detected, its code field will be yellow and the
Alarm Status indicator in the Status Bar of the main window will flash.

NOTE:
Alarms, warnings, and diagnostics results can also be reported via pin 3 of
the device’s D-connector. This pin is configured as an open collector
output. The maximum source current is 25 mA when grounded. To enable
this feature, refer to “7.6 Configuring Alarm Settings” on p. 7-25.

6.5.1.1 Clear Latched Alarm and Warning Conditions

A Latching option can be set for each alarm/warning condition. If latching is
enabled for a specific alarm/warning condition and that condition occurs,
the latched state will persist even if the alarm/warning condition goes away.
However, if you know that it is safe to operate the device, you may want to
clear the latched alarm/warning condition.
To clear all latched warning and alarm conditions, click the Clear
Alarm/Warnings button in the Alarms/Warnings subtab of the Alarm Status
tab in the Diagnose window. If an alarm or a warning condition is cleared,
the alarm or warning will latch again if the condition reoccurs.

6.5.2 Checking Device Diagnostic Status

The device continuously runs diagnostics. If the diagnostics detect a fatal
error, the device will briefly flash the Status LED red and then reset itself
after approximately 5 seconds. The tests are listed in Table 6-3 on p. 6-14.
NOTE:
The periodic device resetting that occurs during a diagnostic fault condition
will make communication with the Service Suite impossible. If a diagnostic
failure occurs, please make arrangements to return the device to your
nearest service center.
The results of the most recent diagnostic fault(s) are displayed in the
Diagnostics subtab of the Alarm Status tab in the Diagnose window.
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Table 6-2 Diagnostic Tests

Diagnostic Failure Description

Flash Memory 8-bit checksum of the Flash memory device.

RAM Memory Byte-by-byte test of RAM; detects bad memory
location.

Non-Volatile Memory Byte-by-byte test of non-volatile memory; detects
bad memory location.

Temperature Sensor Temperature sensor reports a value outside the
nominal range of 32 to 212ºF (0 to 100ºC).

Internal (Device) Power Supply Any internally generated power supply voltage
outside operational limits. Internal supply voltages
must be within their nominal limits.
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6.5.3 Modifying Flow Alarms Behavior

You can modify the behavior of all flow-related alarms to become
automatically disabled when one or both of the following conditions exist:
setpoint is zero and valve override is active.
These options are available from the Alarm Behaviour subtab of the Alarm
Status tab in the Diagnose window.
NOTE:
Flow-related alarms/warnings are considered to be:
• Flow 1
• Flow 2
• No Flow Indication
NOTE:
More comprehensive configuration tools for alarms and warnings are
available using the Tune function. For more information, refer to
“7.6 Configuring Alarm Settings” on p. 7-25.
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• Output Alarm Behavior. The setting selected for this option
determines what will happen to the output flow signal if there is an
alarm condition. The available settings are:

• Track Flow. Output will continue to report the value of the measured
process variable.

• Hold Last. Output will remain at the value in effect when the alarm
condition was detected.

• Upscale. Output will go to the maximum output signal.

• Downscale. Output will go to the minimum output signal.

NOTE:
The Output Alarm Behavior parameter affects both the analog output and
flow output as reported by the S-Protocol (for devices so equipped).

• Disable all ‘flow’ alarms when the setpoint is zero. When this
option is selected, any flow-related alarm/warning will not occur if the
setpoint is zero. For example, if the Flow 1 parameter alarm is enabled
and you do not want the alarm to occur while the setpoint is zero (flow
is commanded to be zero), causing flow to be less than the lower limit,
select this option.

• Disable all ‘flow’ alarms during the valve override condition. When
this option is enabled, any flow-related alarm/warning will not occur if
the valve override is in the open or closed state. For example, if the
Flow 1 parameter alarm is enabled and you do not want the alarm to
occur while the valve override is set to open, causing flow to exceed
the upper alarm limit, select this option.
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6.5.4 Modifying Zero Drift Diagnostics

If the mass flow controller device supports the Zero Drift Diagnostics
feature the Zero Drift Alarm can be enabled in the ‘Alarm Settings’ window,
see section 7.6 Configuring Alarm Settings. If this feature is not supported
by the mass flow controller device the ‘Warning’ and ‘Alarm’ options in the
‘Alarm Settings’ window will be disabled. The table below lists the Zero Drift
Diagnostic related parameters which can be configured.

Name Description 
Adjust Error Limit For 
Temperature 

If this option is disabled, then the limit is defined by the user 
configurable Error Limit parameter. If this option is enabled, 
then the limit is computed to be the greater of the user 
configurable Error Limit parameter and the maximum 
allowable drift per the device’s Zero Drift specification 

Alarm Delay The time that the flow signal must exceed the Error Limit 
before the alarm is activated.  The range for delay values is 0 
– 99.9 seconds with 0.1 sec. resolution. 

InterLock Delay The time period between setpoint becoming zero and alarm 
monitoring starts.  The range for Interlock delay parameter is 
0 – 99 minutes with 0.1 min. resolution. 

Safe State Enable If the Safe State Enable is set to ENABLED, then the device 
will transition to a state such that the valve will go to the Valve 
Override Closed state, the device will not respond to setpoint, 
and flow output signal will be reported as 0.0.  The Module 
Status LED will flash Red to indicate that the device is in this 
state.  This state will be referred to as the Recoverable Fault 
State.  To recover from this state, a Zero operation or a 
power cycle of the device must be performed. 

 

Table 6-3 Zero Drift Diagnostics Parameters

These options are available from the Zero Drift Diag Subtab of the Alarm
Status tab in the Diagnose window.
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6.6 Data Logging

This Data Log window allows the user to periodically log the data of the
selected variables in the graph window. The target file needs to be selected
or created using the Browse button. The Log Rate must be specified from
1ms and up.
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7.1 Tuning for SLA Series Devices

This section provides procedures for using the Service Suite to adjust the
device to ensure optimum performance.

The Service Suite includes several functions that allow you to tune and
calibrate the device:

• Zeroing the sensor, to properly set the device to the no-flow state.

• Adjusting the valve offset and span, to optimize the valve behavior
during process conditions.

• Calibrating the device’s input and output signals, to ensure that the
device is accurately reading setpoint and setting its output signal.

• Configuring Alarm settings, to set and modify the conditions under
which an alarm or warning event may occur.

These functions can be accessed via the Tuning function, available from
the Service Actions menu.

7.1.1 Zeroing the Device's Sensor (Supported by 48xx)

Zero is the only available function for the 48xx in Tuning.
The Service Suite’s Sensor Adjust function allows you to zero the device’s
sensor when there is a no-flow condition. The device also includes a Zero
pushbutton (located at the side of the device) that performs this same
function.
To zero the device’s sensor:
1. Allow the device to be powered on for 45 minutes so that it achieves its

operating temperature.
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2. Close the downstream shutoff valve.

The device should be full of process gas with no pressure differential.

3. Wait at least 30 seconds for the flow signal to drop to zero.

4. Using the device’s Zero pushbutton or the Service Suite’s Sensor
Adjust function, zero the device:

If using the pushbutton, press the pushbutton until the device’s
Status LED flashes red, then release the pushbutton. A successful
zeroing operation is indicated by the Status LED being a steady green.

If using the Zero Sensor function, open the Actions menu and
choose Service Actions>Tune to display the Tuning dialog box.

On the Sensor Adjust tab, click the Zero button. A message box
displays when the zeroing operation is complete.

In either case, the zeroing operation can take up to 10 seconds to
complete.

If you attempt to zero the device using the Sensor Adjust function
while gas is flowing at ³5% of full scale, a dialog box displays prompting
you to confirm whether you want to continue with the operation. This allows
you to zero the device if there is some reason for which you want to zero
the device with low flow.
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If the unit cannot zero the device (for example, the device is
malfunctioning, flow is too high, or the flow oscillates), a dialog box displays
indicating that the device cannot be zeroed.

7.2 Valve Tuning

The Service Suite includes a Valve Tuning function that allows you to tune
two valve parameters to optimize its performance:

• Valve offset (flow off, 0%)

• Valve span (at flow + span, flow is just at fullscale, 100%).

Device performance can be affected by contaminants or pressure
changes. Tuning the valve offset and span can help to optimize the valve
response.

At process conditions with process flow:

• The valve offset value corresponds to the valve position (measured as
a percentage from fully closed to fully open) at which flow is off.

• The valve span value is used to determine the valve position—
offset + span—at which flow is just at fullscale.

All valve offset values are calibrated at the factory at the conditions
specified on the device’s production order.



7-4

Installation and Operation Manual
X-SW-BSS-eng

Part Number: 541B033AAG
September, 2013Brooks® Service SuiteTM

Section 7 Tuning
(Not supported by 48xx)

7.2.1 Checking the Offset and Span Values

To check the offset and span values:
1. Open the Actions menu and choose Service Actions>Tune to display

the Tuning dialog box, then go to the Valve Tuning tab.

2. Set inlet and outlet pressure conditions to match those specified on the
device’s order or on its Calibration Report.

3. Click the Adaptive Control Disable button to make sure that Adaptive
Control is not on.

4. In the Manual Tuning panel, click the Manual button to enable the
Valve Position (Current) field.
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5. Starting with 0, enter percentage values in the Valve Position
(Current) field (press the Enter key after entering a value) until the flow
rate just begins (1%).

At this point, the value in the Valve Position (Current) field should be
very close to the value shown in the Valve Offset (Stored) field. Some
small difference between Valve Position (Current) and Valve Offset
(Stored) is acceptable.

6. Continue to enter higher values in the Valve Position (Current) field
until 100% flow is reached.

At this time, the value in the Valve Position (Current) field should be
very close to the sum of the values in the Valve Offset (Stored) and 
Valve Span (Stored) fields. Some difference in these values is
acceptable.

You should adjust the offset and span values if one of the following are
true:

• The process conditions are now different from that specified on the
device’s order.

• The valve position that produces a flow rate of 1% does not closely
match the offset value in the Valve Offset (Stored) field.

• The valve position that produces a flow rate of 100% does not closely
match the current offset + span values in the Valve Offset (Stored)
and Valve Span (Stored) fields.
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7.2.2 Adjusting the Offset and Span Values - Manual Tuning

To adjust the offset and span values manually:

1. Set inlet and outlet pressure conditions to your process or application
specs.

2. Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box, then go to the Valve Tuning tab.

3. Click the Adaptive Control Disable button to make sure that Adaptive
Control is not on.

4. In the Manual Tuning panel, click the Manual button to enable the 
Valve Position (Current) field.
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5. Starting with 0, enter incremental values in the Valve Position
(Current) field until flow just begins (press the Enter key after entering
a value). Make sure you have stopped at £1% flow.

NOTE:
Do not overshoot and then decrease the valve value to locate the offset
position. Because of valve hysteresis, you must start at zero and find the
offset value only by increasing up from zero.

6. Press the Save Offset button to save the new offset value.

7. Once the offset value is determined and set, continue to slowly
increment the current valve value. As flow rate approaches 100%, enter
values in smaller increments until 100% flow is achieved.

8. Allow the flow rate to stabilize. When the flow rate has stabilized, press
the Save Span button to save the new span value.

9. Enter different values in the Value Position (Current) field to
determine whether or not the newly saved offset and span values
produce the desired flow rates, that is, 1–2% with the valve drive at
offset, and 100% with the valve drive at offset + span.

10. Click the Normal button to return the valve to its normal operating
state.
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7.2.3 Adjusting the Offset and Span Values - Auto Tuning

The Auto Tune function determines the valve offset and span values
automatically.

To adjust the offset and span values using the Auto Tune function:
1. Set inlet and outlet pressure conditions to your process or application

specs. Select the Service Suite as the setpoint source in the graph
window and configure 0% setpoint.

2. Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box, then go to the Valve Tuning tab.

3. Click the Auto Tune button to start the operation.

You are prompted to enter step values. These values define the low
(Set 1) and high (Set 2) valve step values that will be used to adjust the
valve during the second phase of the Auto Tune operation. The Dwell
values determine how long to maintain the step value before switching
to the next value.
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NOTE:
It is recommended to keep the User Inputs parameters at their default
settings.

4. Enter the step values and dwell time in the User Inputs dialog box, then
click OK.

The Auto Tune operation starts.

In the first adjustment phase, the device valve is opened in gradual
steps to determine an approximated rough valve offset.

In the second adjustment phase, the setpoint is repeatedly cycled
(according to the setpoint cycling values that you specified) until offset
and span differences are below an acceptable threshold, or for a
maximum of six cycling periods. This adjustment process can take
several minutes.



7-10

Installation and Operation Manual
X-SW-BSS-eng

Part Number: 541B033AAG
September, 2013Brooks® Service SuiteTM

Section 7 Tuning
(Not supported by 48xx)

   When the Auto Tune operation is complete, a message box displays.
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7.2.4 Dynamically Adjusting the Offset and Span Values During Device Operation

The Valve Tuning Adaptive Control function, when enabled, causes the
device to dynamically adjust valve offset and span, or just offset, while the
device is operating.

If process conditions change significantly (such as moderate shifts in inlet
or outlet pressure) while Adaptive Control is enabled, valve offset and span
will dynamically self-adjust for optimum valve performance under the new
process condition without requiring operator intervention.

To enable Adaptive Control, open the Actions menu and choose
Service Actions>Tune to display the Tuning dialog box, then go to the
Valve Tuning tab. In the Adaptive Control panel:

• Select the Offset and Span or Offset Only option from the Mode
Select drop-down list.

• Click the Enable button.

NOTE:
When adaptive control is enabled, offset and/or span may change
dynamically. However, these changes are not permanent, and the device
returns to the stored offset and span after a power cycle or system reset.
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7.3 Response Tuning

Response tuning optimizes the dynamic performance of the mass flow
controller device to changes in setpoint. You can use this feature to
eliminate undesired flow under- and overshoot.
If the mass flow controller device supports the Improved Response and
Control feature also PID Kd (derivative gain) value can be changed. If this
feature is not supported by the mass flow controller device the PID Kd
value can not be changed.

NOTE:
For devices calibrated at the factory, response tuning adjustments should
not be necessary, as calibrations are performed to the device’s specified
process conditions. If you do want to adjust the response tuning, it is
strongly recommended that you adjust only the PID Kp and Ki
(proportional and integral gain) values. Do not adjust the Flow Control
K-up and K-down values. For Service Suite training, which includes
training for response tuning, contact your local Brooks service
representative.

To tune the device’s response, you will set up a square wave for the
setpoint. You will then make adjustments to tuning parameters to make the
actual flow graph match the setpoint’s square wave.

To tune the device’s response:

1. Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box, then go to the Response Tuning tab.

The sample screen below shows the default tuning values.
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2. Position the Graph window so that you can see the Tuning and Graph
windows at same time.

3. Set up the setpoint square wave, as shown in Figure 7-1. You should
pick high and low setpoints that are at the expected range of your
process application.

NOTE:
The Brooks Service Suite is intended to be used for mass flow controls
and mass flow meters. If you are adjusting a meter model, use a separate
flow controller to regulate the setpoint cycling.

4. Make sure that the Adaptive Control Enable option is not selected.

5. Click the Start button to begin flow.

Figure 7-1 Setting Up the Setpoint Square Wave

Enter the elapsed time
before wave switches
to other setpoint

Select option here
to hold setpoint
at the high or low
value

Manually enter high
and low setpoints here

Click these buttons to select one
of the preset square waves
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6. Observe how closely the actual flow matches the setpoint square wave.

7. Start making adjustments using the PID Kp and Ki (proportional and
integral gain) values. (Do not adjust the Flow Control K-up and
K-down values.)

Figures 7-2 and 7-3 shows some examples of what the flow graph
looks like when Kp and Ki values are too high or too low.

NOTE:
If you are having difficulty getting the actual flow graph to look like the
setpoint square wave, you can restore the initial settings that were in effect
when the window was opened by clicking the Restore Settings button.
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Figure 7-2 Kp Value Is Too High, or Ki Value Is Too Low

Figure 7-3 Kp Value Is Too Low, or Ki Value Is Too High
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7.4 Setting and Calibrating the Output Signal

The Output Adjust function allows you to change the output signal setting
and its operating parameters. After making changes to the output signal
setting, you must calibrate the device to the new signal setting.

To access the Output Adjust function, open the Actions menu and
choose Service Actions>Tune to display the Tuning dialog box, then go to
the Output Adjust tab.
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7.4.1 Viewing and Changing the Output Signal Setting and Parameters

In the Output Configuration panel of the Output Adjust tab, you can:

• Change the type of signal (for example, from 0–5 Vdc to 0–20 mA).

• View the current output signal parameter values. These parameters are
explained in Table 7-1.

NOTE:
If you change the output signal type, you will be prompted that you must
calibrate the signal, and that all old output signal calibration settings will be
lost. However, you could click the Restore button in the Output Calibration
panel to return to the previous calibration settings.

Table 7-1 Output Signal Parameters (Read Only)

Parameter Description

Damping Used as a low-pass filter in the analog output only
(actual flow is not affected). Higher values slow
down the output response. The default is
1.5 seconds. The range is 0 to 10 seconds.

Low Output Cutoff When the measured flow is below this value, the
analog flow output will be set to its zero (no flow)
value.

Output Lock-in Error Limit The analog flow output value will “lock in” to the
setpoint whenever the error between measured
flow and setpoint is less than this value.

Transient Lock-in Time When this feature is enabled (non-zero) and a
change in setpoint is detected, the analog flow
output signal will equal setpoint for the time
period that is set for this location. At the end of
the time period, the analog flow output signal will
indicate actual flow. Setpoint change must be
greater than ±1% of full scale.
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7.4.2 Calibrating the Output Signal

You can calibrate the device’s output signal to ensure that the device is
accurately setting the output signal and, thus, maintaining the correct flow
relative to the setpoint.
Prior to using the Service Suite to calibrate the device output, you must
connect a DMM to the device’s output signal, which you will use to verify
the actual signal level. Figures 7-4 and 7-5 show how to set up the DMM
for voltage and current output types.
Note that all D-connector pin-outs are listed in “3.5 Device D-Connector
Pin-Outs” on p. 3-8.

Power Supply

13.5 - 27 Vdc

DMM

(Precision 

Voltmeter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

Pin 5

Pin 10

Pin 2

Pin 9

+

_

+

_
DB15 Connector

8

9

Power Supply

13.5 - 27 Vdc

DMM

(Precision 

Current Meter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. R ≤ 500 Ω for supply ≤ 16 Vdc. R ≤ 380 Ω for supply ≥ 16 Vdc.

3. Tie cable shields to ground at one end only.

Pin 5

Pin 10

Pin 4

R

Pin 9

+

_

+

_
DB15 Connector

8

9

Figure 7-4 Setup for Calibrating to an Output Voltage

Figure 7-5 Setup for Calibrating to an Output Current

500380
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To calibrate the device’s output:

1. Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box, then go to the Output Adjust tab.

2. In the Output Calibration panel, click the 2a. Offset button, and note
the measured output signal level on the DMM.

The Service Suite forces the device to output the minimum signal level.

3. Enter the value displayed on the DMM in the offset’s Measured Output
field, then press the Enter key. Continue entering the DMM value until it
is within ±0.1% of full scale.

4. When the DMM value is within ±0.1% of full scale, click the 2b. Span
button.

The Service Suite forces the device to output the maximum signal
level.

5. Enter the value displayed on the DMM in the span’s Measured Output
field, then press the Enter key. Continue entering the DMM value until it
is within ±0.1% of full scale.

6. When the DMM value is within ±0.1% of full scale, click the Check
button to verify the output is properly calibrated.

7. When you have completed verifying the adjustment, click the OK
button to save the calibration settings.

At any point, you can:

• Cancel the changes to all parameter values by clicking the Cancel
button to cancel the calibration. You will be prompted to confirm the
cancellation. If the calibration is cancelled, the most recently saved
calibration data is restored.

• Restore the previous offset and span values by clicking the Restore
button.
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7.4.2.1 Checking the Output signal from the Output Adjust Tab

To check the output signal from the Output Adjust tab, click the Check
button. The 3. Check Output panel displays on the right side of the tab.

You can use the buttons on this panel to check the output signal as set by
the device against the actual signal level measured on a DVM. This
function is the same as that described in “6.1 Testing the Analog Output”
on p. 6-1.
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7.5 Setting and Calibrating the Input Signal

The Input Adjust function allows you to change the input signal setting and
its operating parameters. After making changes to the input signal setting,
you must calibrate the device to the new signal setting.

To access the Input Adjust function, open the Actions menu and
choose Service Actions>Tune to display the Tuning dialog box, then go to
the Input Adjust tab.

7.5.1 Changing the Input Signal Setting and Parameters

In the Configure panel of the Input Adjust tab, you can:

• Change the type of signal (for example, from 0–5 Vdc to 0–20 mA).
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• View values of the input signal behavior parameter values. These
parameters are explained in Table 7-2.

NOTE:
 If you change the input signal type, you will be prompted that you must
calibrate the signal, and that all old input signal calibration settings will be
lost. However, you could click the Restore button in the Configure panel to
return to the previous calibration settings.

Parameter Description

Softstart Mode Normally, the setpoint responds immediately to changes in
value. Alternately, the response of the unit to changes in
setpoint can be affected in either of the following ways:

• Slope. The device will ramp flow from the old setpoint
to the new setpoint with a fixed ramp rate specified by
the user in %/sec.

• Time. The device will ramp flow from the old setpoint to
the new setpoint in the time specified by the user in
seconds.

Low Input Cutoff When the setpoint is derived from an external source, this
parameter sets the minimum valid value of the setpoint. If
the setpoint value reported by the analog input is below
the cutoff value, then the setpoint is effectively interpreted
as zero.

Zero Drift Alarm An alarm or warning will occur when the flow signal starts
to drift during non-flow conditions.

Temperature Alarm Each allows you to set an inclusive minimum and
maximum sensor temperature limit range. Whenever the
sensor temperature is not within the stated range, the
alarm or warning will occur.

Table 7-2 Configurable Input Signal Behavior Parameters (Read Only)

7.5.2 Calibrating the Device Input (Setpoint)

You can calibrate the device’s input to ensure that the device is accurately
reading the setpoint from its external analog source.
Prior to using the Service Suite to calibrate the device input, you must
connect a digital multimeter (DMM) to the device’s setpoint signal, which
you will use to verify the actual signal level. Figures 7-6 and 7-7 show how
to set up the DMM for the available input types.
Note that all D-connector pin-outs are listed in “3.5 Device D-Connector
Pin-Outs” on p. 3-8.
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Power Supply

13.5 - 27 Vdc

Precision 

Voltage 

Source

DMM

(Precision 

Voltmeter)

1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

Pin 5

Pin 8

Pin 1

Pin 9

+

_

+

_

+

_
DB15 Connector

8

9

Power Supply

13.5 - 27 Vdc

Precision 

Current 

Source

DMM

(Precision 

Current Meter)1

15

Notes:

1. Refer to the DMM specifications, as provided by the Service Tool.

2. Tie cable shields to ground at one end only.

3. Input impedance = 125 Ω.

4. Absolute maximum input (without change): 25 mA.

Pin 5

Pin 7

Pin 1

Pin 9

+

_

+

_

+

_
DB15 Connector

8

9

Figure 7-6 Setup for Calibrating to a Voltage Setpoint

Figure 7-7 Setup for Calibrating to a Current Setpoint
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To calibrate the device’s input:

1. Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box, then go to the Input Adjust tab.

2. Set the external analog setpoint to its appropriate zero value, and
confirm this value with the DMM:

• 1.000 for 1–5 Vdc
• 0.000 for 0–5 Vdc
• 4.000 for 4–20 mA
• 20.000 for 0–20 mA

3. In the Input Calibration panel, click the Offset button.

The external analog setpoint offset is now set. This is the minimum
signal level for the setpoint.

NOTE:
Sometimes the valve may oscillate during the time between adjusting
setpoint input offset and span. This is a normal event that will resolve itself
immediately after setpoint input span is adjusted.

4. Set the external analog setpoint to its appropriate full scale value:

• 5.000 for 1–5 Vdc
• 5.000 for 0–5 Vdc
• 20.000 for 4–20 mA
• 20.000 for 0–20 mA

5. In the Input Calibration panel, click the Span button.
The external analog setpoint span is now set. This is the maximum
signal level for the setpoint.

6. Click the OK button to save the calibration data.
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7.6 Configuring Alarm Settings

The Alarm Settings function allows you to set alarm behavior for several
device event conditions.

To access the alarm settings, open the Actions menu and choose
Service Actions>Tune to display the Tuning dialog box, then go to the
Alarm Settings tab.

After changing settings, click the Apply Settings button to save them.

In addition to the Diagnostic alarm, you can enable the device to indicate
warning and alarm conditions related to the event conditions listed in
Table 7-3. The alarm settings are described in Table 7-4.
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Table 7-3 Event Conditions for Which Alarms/Warnings Can Be Set

Event Condition Description

Flow 1 and 2 Each allows you to set an inclusive minimum and
maximum flow limit range. Whenever flow is not
within the stated range, the alarm or warning will
occur. These two general flow alarms provide
more flexibility than having specific low and high
flow alarms. These alarms can be used to create
separate low and high flow alarms. They can also
be used together to monitor deviation about a
flow rate. If the device is a controller, then this
alarm/warning is disabled if the setpoint is not
within the specified flow limits or if the valve
override is active.

No Flow Indication This condition occurs if the measurement of flow
indicates flow less the specified Low Limit value.
The Low Limit value can be from 0–2%. If the
device is a controller, this condition will not set an
alarm/warning unless the setpoint exceeds the
configured limit and valve override is inactive.

Setpoint Deviation An alarm/warning condition occurs if the
difference between the setpoint and flow exceeds
the specified limits for more than the specified
delay period. This alarm/warning is disabled if the
valve override is active.

Totalizer Overflow This condition occurs if the Flow Totalizer value
exceeds its maximum value and resets to zero.
This parameter is permanently configured as a
latch-type alarm/warning, which requires you to
use the Clear Alarms/Warnings button on the
Alarm Status tab or the S-Protocol interface to
reset the alarm/warning.

User Power Supply An alarm/warning condition occurs if the power
input to the device is outside the specified range.
You can make the voltage limits smaller than the
default range if you want to monitor your supply
voltage to a tighter specification than the device
requires.
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Table 7-3 Event Conditions for Which Alarms/Warnings Can Be Set (cont.)

Event Condition Description

Setpoint Out of Range An alarm/warning condition occurs if the
difference between the setpoint and flow exceeds
the specified limits for more than the specified
delay period. This alarm/warning is disabled if the
valve override is active.

Flow Output Out of Range An alarm/warning condition occurs if the
measured flow results in an analog output that
exceeds the specified range for either the voltage
or current output.

Flow Output Loop Open An alarm/warning condition occurs if the device
detects that there is no current flowing on the
current loop. The alarm/warning condition could
be the result of an open connection on the analog
output current loop.

Flow Sensor Out of Range An alarm/warning condition occurs if the device
detects that the signal received from the sensor is
not within the allowable tolerance band. This
alarm/warning condition could be the result of a
flow sensor failure.

Zero Drift Alarm       An alarm or warning will occur when the flow
      signal starts to drift during non-flow conditions.

Temperature Alarm      Each allows you to set an inclusive minimum and
     maximum sensor temperature limit range.
     Whenever the sensor temperature is not within
     the stated range, the alarm or warning will occur.
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Table 7-4 Alarm Settings

Field/Option Description

Alarm choice Options are:

                               •   Off. No warning/alarm will be set if the alarm/warning
condition occurs.

• Warning. A warning will be set if the alarm/warning condition
occurs. Alarm LED flashes green, but the device will continue
normal operation.

• Alarm. An alarm will be set if the alarm/warning condition
occurs. Alarm LED flashes red. Device will enter its safe
state. If the alarm was set by the device diagnostics, a
diagnostic alarm is set and the device will reset after 5
seconds.

The safe state is defined as:

• The valve is unpowered (the valve will close for a normally
closed valve, or will open for a normally open valve).

• The analog output will reflect the flow under the valve’s safe
state condition.

Latching Enable If selected, the warning/alarm condition will persist, even if the
condition goes away. You must use the Clear Alarms/Warnings
button on the Alarm Status tab to reset the alarm/warning.

Contact Enable If selected, a warning/alarm condition for this variable will cause
the open-collector output at pin 3 of the device’s D-connector to
be active.

D-connector 
pin 3

25 mA sink (MAX)

30 Vdc (max)

R

R can be any device that the user chooses to indicate an alarm/
warning/diagnostic failure condition. No matter what is chosen,
input current to pin 3 must be limited to 25 mA (closed) and
applied voltage must be less than 30 Vdc (open).

Flash Code The code flashed by the Alarm LED to indicate a warning/alarm
condition for this parameter.

Low Limit Lower limit for this parameter. If the Alarm option is set to
Warning or Alarm, and the parameter’s data value drops below
the low limit value, the parameter’s warning/alarm condition will
be active.
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7.7 Alarm Status

The Alarm Status tab in the Tuning dialog box is the same as that in the
Alarm/Warning Status subtab of the Diagnose dialog box. For more
information, refer to “6.5 Checking the Warning, Alarm, and Diagnostic
Status” on p. 6-12.

Table 7-4 Alarm Settings (cont.)

Field/Option Description

High Limit Upper limit for this parameter. If the Alarm option is set to
Warning or Alarm, and the parameter’s data value exceeds the
high limit value, the parameter’s warning/alarm condition will be
active.

Delay Number of seconds that the warning/alarm condition must be
active before the warning/alarm is indicated on the Alarm LED
and Alarm contact (and reported to the Service Suite application,
if a session is open).
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7.8 Tuning: Zeroing the Device's Sensor

The Service Suite's Sensor Adjust function allows you to zero the device's
sensor when there is a no-flow condition.
To zero the device's sensor:
1. Allow the device to be powered on for 45 minutes so that it achieves its
operating temperature
2. Close the downstream shutoff valve.
The device should be full of process gas with no pressure differential.
3. Wait at least 30 seconds for the flow signal to drop to zero.
4. Use the Service Suite's Sensor Adjust function to zero the device:

Open the Actions menu and choose Service Actions>Tune to display the
Tuning dialog box.

On the Sensor Adjust tab, click the Zero button. A message box displays
when the zeroing operation is complete.
The zeroing operation can take up to 10 seconds to complete.
If you attempt to zero the device using the Sensor Adjust function
while gas is flowing at 5% of full scale, a dialog box displays prompting
you to confirm whether you want to continue with the operation. This allows
you to zero the device if there is some reason for which you want to zero
the device with low flow.
If unable to zero the device (for example, the device is malfunctioning,
flow is too high, or the flow oscillates), a dialog box displays indicating that
the device cannot be zeroed.”
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8.1 Gas Calibration and Reporting (Pro Version Only)

This section explains how to use the advanced calibration and reporting
functions available in the Brooks Service Suite Pro version.

The device must be calibrated so that it can accurately read flow rates.

8.1.1 Required Conditioning During Calibration

To perform calibration, the following conditions are required:

• The device has been powered on for at least 45 minutes.

• The sensor has been zeroed.

• There is a supply of gas.

• During the calibration process, the device must be in a thermally stable
environment. Rapid or significant temperature changes during the
calibration process will affect the device’s accuracy.

• When clicking the 'Linearize Sensor' or 'Check Linearization' button
in the main calibration window, the option is given to start with a cleared
'Linearize Sensor' or 'Check Linearization' screen or show the previous
values, it is possible to perform a rerun of one or more rows in the
'Linearize Sensor' screen and recalculate the polynomials. Note that
this is not recommended and that it might affect the accuracy, for the
second run might be performed in different ambient conditions. In order
get the best accuracy it's recommended to perform all runs in one go.

• When performing a linearization in ‘Reference Meter’ or ‘Manual Vol-U-
Meter’ mode, a window will pop-up, showing a decrementing counter,
when a button in the ‘Start’ column is clicked. This window will
automatically close when the timer has reached 0, do not close this
window because it might affect the accuracy.

8.1.2 Device Accuracy

The accuracy which is used during the check calibration phase, is
automatically derived from the model code and depends on the device
specification.
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8.2 Available Calibration Methods

You can use one of the following calibration methods:

• Reference Meter Mode. The reference meter must be connected in
series with the device being calibrated. Make sure the reference meter
can measure flow at least 1.5 to 4 times the desired full scale
calibration flow amount. For a truly accurate gas calibration, the
reference meter must be substantially more accurate than the device
being calibrated.

• Manual Vol-U-Meter Mode. This method requires a Brooks 
Vol-U-Meter, which can be obtained by contacting your local Brooks
representative. The Vol-U-Meter provides a precise means of
measuring flow rate. This method also requires a Brooks 1060
Vol-U-Meter Read-Out Device, for reading the flow data from the
Vol-U-Meter. With regard to flow, the Vol-U-Meter is connected in series
with the device being calibrated.

• Automatic Vol-U-Meter Mode. This method requires a Vol-U-Meter
and 1060 Read-Out Device. However, instead of you reading data from
the 1060 display and entering them manually in the Service Suite
application, the 1060 is connected to the PC via a serial cable and the
data are read into the application automatically.

8.3 Meter Calibration

There are two ways of calibrating a meter using Service Suite.

•     Using the valve output of the meter. Since the meter version of
Brooks SLA products contains the same electronics circuitry as the
controller version, it’s possible to connect a standalone valve or a
compatible valve from a Brooks SLA controller to the valve output of the
electronics circuitry. If the device type in the Product Data tab of the
Calibration window is changed to MFC (controller) during the calibration
phase, the device will act as a controller. After calibration the device type
needs to be configured back to MFM. Note that this valve connected to the
meter needs to be in the flow path during calibration. Using this setup all
calibration methods are supported.
•     Using an external valve. In case it’s not possible to connect a
standalone valve or a compatible valve from a Brooks SLA controller to the
valve output of the electronics circuitry, it’s possible to put an external valve
in the flow path and regulate flow using this external valve. Note that the
device type needs to be configured to MFM, this will adjust the behavior of
the Optimize Sensor, Linearization and Check Linearization functionality in
the Service Suite. In the Optimize Sensor functionality the user will be
asked to adjust the flow indicated in the pop-up window, to a certain
percentage by using the external valve. In the Linearization and Check
Linearization process the user needs to adjust the flow using the external
valve to the desired flow value before clicking the start button. Using this
setup the auto vol-u-meter calibration method is not supported.
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8.4 Preliminary Setup Tasks

The following topics describe the preliminary setup tasks that are required
prior to performing the calibration.

8.4.1 Entering the Vol-U-Meter Tube Characteristics (SLA only)

If you are going to use either of the Vol-U-Meter modes, you must enter the
Vol-U-Meter’s tube characteristics in the Service Suite.

The  Vol-U-Meter can have up to three tubes. Each tube has pick-offs,
from which it reads when the rising piston passes. The 1060 calibrator then
uses this data to calculate the flow rate. The Service Suite needs to know
how many pick-offs each tube has and what measurement each pick-off
represents.

Each  Vol-U-Meter comes with a sheet that lists the pick-offs and their
measurement values. You will need this form when entering the pick-off
values in the Service Suite.

To enter the Vol-U-Meter’s tube characteristics:

1. Open the Tools menu and choose Tube Characteristics.
The Tube Characterization dialog box displays.
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2. Referring to the Vol-U-Meter’s tube data sheet, enter the values for the
pick-offs. There is a tab available for each tube.

3. In the Piston Pressure field, enter the piston pressure in mm-H2O or
mbar. Select the related radio button for the UOM of the piston
pressure. The pressure will be the same for all three tubes. The
standard pressure value is 50.8 mm-H20.

4. Enter the tool number of the Vol-U-Meter to uniquely identify it.

The tool number that you enter is used as the file name for the tube
characterization file that is created as a result of entering the data in
this dialog box.

5. When entering data in the dialog box, click the Apply button at any
time to save what you have entered.

6. When you have completed the fields, click the New File button.
The Tube Characterization Save File dialog box displays.

7. Enter a name for the tube characterization, then click the Save button.

8. When you are done entering the characterization data, click the Exit
button.

If you want to change the tube characterization data at a later time, you can
click the Open File button in the Tube Characterization dialog box. From
the Open File dialog box that displays, you can select the tube
characterization file to load in the Tube Characterization dialog box.
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8.4.2 Accessing the Calibration Functions (SLA only)

All calibration-related functions are executed from the Calibration window.
To display the Calibration window, open the Actions menu and choose
Calibration Actions>Calibration.

To perform the calibration, you will go sequentially through tabs 1 through
5. The following topics discuss the preliminary tasks associated with tabs 1
through 4. You will then perform the linearization calibration from tab 5.

The functions on tabs 6 through 11 allow you to perform tuning operations,
exactly as those described in Section 7.

The function on tab 12 allows you to save the device calibration data to a
file. This file can be used to restore the device configuration, if necessary.
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8.4.3 Entering the Device's Product Data (SLA only)

Go to the Product Data tab in the Calibration window. Using the information
on the device’s product order or data sheet, complete the fields on this tab
(Press the Enter key after each text entry). Only the Model Number and
Serial Number fields are required; however, the data entered here does
appear on the Calibration Report to provide identifying information about
the device that has been calibrated.
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8.4.4 Entering the Device's Process Application Data (SLA only)

In the Gas Cal. Data tab, you enter information about the process
application in which the device is to be used

To support calibrations for using the device under multiple process
application conditions, you can enter and save up to 10 Gas Calibration
Data sets. Each calibration set is saved in the device. When the tab is
displayed, the Service Suite loads the most recently used set. In case no
set has ever been created the fields are disabled and a new set needs to
be created. The “Gas. Cal #” field will indicate 0 in this case.

To enter gas calibration data for the process conditions to which you are
currently calibrating the device:

1. Click the Select Gas Calibration button.
A pop-up window displays.

2. To load an existing set, select the set’s number from the Select Gas
Cal Record drop-down list.
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To create a new set, select a set number that has not been used yet
from the Select Gas Cal Record drop-down list.

3. Complete the Full Scale Value and Gas Name fields for the target
process conditions, then click the Close button. Note that both fields
refer to the process gas.

The Gas Cal. Data tab is loaded with the data from the selected set, or
with default data if you are creating a new set.

4. Enter the process application data for the current calibration in the Gas
Cal. Data tab fields (press the Enter key after each text entry).

Table 8-1 describes some of the parameters.

Table 8-1 Descriptions of Selected Gas Calibration Data Parameters

Parameter Description

Gas Cal # Number assigned to the currently loaded Gas
Calibration Data set.

Cal Type For Brooks internal use only.

Ref. Temp Indicates the temperature of the process gas, from
which volumetric flow will be inferred.

Ref. Press. Indicates the pressure of the process gas, from
which volumetric flow will be inferred.

Process Gas Density Density of the process gas at reference conditions
(see Ref. Temp and Ref. Press. descriptions above).
Used to determine mass flow when requested by the
user (refer to the units of measure description in
Figure 4-3 on p. 4-6).

Process Gas Full Scale The volumetric flow value of the process gas at
reference conditions when setpoint = 100%.

Cal. Gas Correction Factor When a gas other than the process gas is used to
calibrate the device, this factor is multiplied with the
Process Gas Full Scale parameter to compensate
for differences in gas properties.

Note: The Service Suite application maintains an internal database of
product and gas calibration data. Clicking the Save button on this tab
saves this data to the internal database. This feature should not be
confused with the Save Device configuration feature, which is used to store
all device internal parameters to a separate file.
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Table 8-1 Descriptions of Selected Gas Calibration Data Parameters (Cont.)

Process Gas Density Density of the process gas at reference conditions
(see Ref. Temp and Ref. Press. descriptions above).
Used to determine mass flow when requested by the
user (refer to the units of measure description in
Figure 4-3 on p. 4-6).

Process Gas Full Scale The volumetric flow value of the process gas at
reference conditions when setpoint = 100%.

Cal. Gas Correction Factor When a gas other than the process gas is used to
calibrate the device, this factor is multiplied with the
Process Gas Full Scale parameter to compensate
for differences in gas properties.

8.4.5 Zeroing the Device

Before starting the calibration, you must zero the device using the controls
on the Sensor Adjust tab. This ensures that, in the absence of flow, the
device measures no flow.

For the zeroing procedure, refer to “7.1.1 Zeroing the Device’s Sensor” on
p. 7-1. That procedure refers to using the Sensor Adjust tab in the Tuning
window, accessed through the Service Actions option in the Actions
menus. However, the functionality on both Sensor Adjust tabs is exactly the
same.

8.4.6 Valve Pre-Adjust (SLA only)

Before starting the calibration, you must tune the device’s valve using the
controls on the Valve Pre-Adjust tab. This ensures that the valve is
performing properly.

For the valve tuning procedure, refer to “7.2.1 Tuning the Valve Offset and
Span” on p. 7-4. That procedure refers to using the Valve Tuning tab in the
Tuning window, accessed through the Service Actions option in the
Actions menus. However, the functionality on the Valve Pre-Adjust and the
Valve Tuning tabs is exactly the same.
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8.5 Automatic Vol-U-Meter® Mode Calibration (SLA only)

8.5.1  Equipment Setup for Automatic Vol-U-Meter Mode Calibration

For Automatic Vol-U-Meter mode, set up the equipment as shown in
Figure 8-1.

Vol-U-Meter

1060 
Calibrator

PC running 
Brooks Service Suite

Target device 
being calibrated

9-pin null modem 
serial cable

Vent to desired 
pressure condition

From gas 
supply

15-pin 
cable

Gas out

Gas in

15-pin 
D-connector 

cable

Figure 8-1 Equipment Setup for Automatic Vol-U-Meter Mode Calibration
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8.5.2 Having the Service Suite Recognize the 1060 Device

To have the Service Suite recognize the 1060 device, open the Tools menu
and choose 1060 Comm Settings. The 1060 Port Settings dialog box
displays.

Select the Comm port on the PC to which you connected the serial cable
from the 1060, then click OK.

8.5.3 Performing the Automatic Vol-U-Meter Mode Calibration

You access the calibration functions from the Linearization tab.

To perform device calibration in Automatic Vol-U-Meter mode:

1. In the Select Linearization tool panel, select the Auto Vol-U-Meter
option.

2. Click the Select Vol-U-Meter button.
An Open dialog box displays.
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3. Select the Tube Characterization set that you want to use for this
calibration, then click the Open button to load it.

4. Select the Vol-U-Meter tube you are going to use from the Select Tube
Number drop-down list.

In the Linearization tab, there are four buttons; you are going to go through
these in sequence to perform and check the calibration. The first step is to
clear the coefficients a0 through a4 of the polynomial. This is the
polynomial of the curve that is used to linearize the mass flow sensor.

5. Click the Default Polynomials button to clear the coefficients.
A dialog box displays when the clearing process is complete.

6. Click OK to dismiss the dialog box.
The polynomial coefficients are cleared.
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If it's not possible to perform the optimization of the sensor you can
configure Default settings by clicking the Default button and skip the steps
below. This will configure the Sensor Drive Setting to 0.81 (proceed with
numbered item 10).
In case the device type is set to Mass Flow Meter (MFM) the flow needs to
be adjusted by using an external valve. Two additional pop-ups will appear
to indicate this, adjust the flow by using the external valve such that the
'Flow(%)' indicates the suggested value. A difference between the actual
and suggested flow of 1% is allowed.

7. Click OK to start the Optimize Sensor process.
The process runs: (1) making sure that the device flows at least to its full
scale value; and (2) optimizing the gain of the thermal mass flow output. A
dialog box displays when the optimization completes.

8. Click OK to dismiss the dialog box.

9. Click the Linearize Sensor button.
In case of Auto or Manual Vol-U-Meter mode you are prompted to enter
the ambient pressure.
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10. Enter the ambient pressure, then click OK.

The Linearization Calibration window displays.

By default, there are six Linearization Data Points with setpoint settings (as
percentages of full scale flow) entered. It is recommended to use the
default settings. But the desired flow can be changed to the required
values. There are 2 option buttons Default and Custom. If the values are
changed in any of the fields the Save Custom Values button will get
enabled. By clicking on this button the custom flow values can be saved.
For the next time we can use the default values or the stored custom
values by choosing the required option.
Each setpoint setting has a corresponding Vol-U-Meter pick-off selected.
This is the pick-off that will be used when determining the actual flow rate
for that setpoint.
You can change the setpoint values and pick-offs used. However, make
sure you pick a flow rate and pick-off that will allow flow to continue for at
least 30 to 60 seconds before the piston rises past the selected pick-off.
The higher the flow rate, the faster the piston will move, and so the higher
the pick-off that should be used. The pick-off volumes are included on the
Vol-U-Meter's data sheet, and are much more accurate than a visual
determination.
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Normally, just use defaults for Automatic Vol-U-Meter mode. However, if
you are certain that your system and Vol-U-Meter have no leaks, then you
could use a higher pick-off for a lower flow rate, to compensate for any
initial flow spike that may occur as a result of triggering the Vol-U-Meter to
begin a flow run.

11. To start the linearization process, click the Execute Linearization
button.
A message flashes, indicating the execution of an initial check
operation.
When the check operation is complete, the Linearization process sets
the setpoint to the percentage of the first Data Point row and waits 30
seconds to allow the mass flow sensor to stabilize. After the
stabilization delay, the piston in the Vol-U-Meter starts rising. When it
reaches the assigned pick-off, the Linearization process updates that
Data Point’s Pick-off Volume, Time, and Flow values.

When one Data Point flow run completes, the Linearization process
starts the next one. Between each flow run, the application sets the
setpoint to the next value and allows 30 seconds for the sensor to
completely stabilize. The following screen shows what the window
looks like after the second Data Point flow run was complete.

NOTE: During the Data Point flow runs, the Execute Linearization
button changes to a Pause button, allowing you to pause the
process.

When all Data Point flow runs are complete, the Calculate Polynomial
button enables.
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12. Click the Calculate Polynomial button.

A dialog box indicates that the polynomial coefficients have been
stored.

13. Click OK to dismiss the dialog box, then click the Exit button to
close the Linearization Calibration window.

The updated coefficients are displayed in the Linearization tab.
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14. Click the Check Linearization button.

In case of Auto or Manual Vol-U-Meter mode you are prompted to
enter the ambient pressure.

15. Enter the ambient pressure, then click OK.

The Linearization Calibration window displays, but with two additional
columns of data: Measured Error and Spec. Error Limit.

In the next series of steps, you are going to check the flow for different
Data Points, but using the updated linearization polynomial. The Check
Linearization process will check the results against the expected flow rates,
and display deviation error values for each Data Point flow run.
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16. You can change the setpoint setting and pick-off for each Data Point;
however, it is recommended that you use the default values for the six
Data Points.

17. To start the Check Linearization process, click the Start Check button.

The Data Point flow runs are performed, as in the Linearization
process, but using the new linearization polynomial. After each run,
deviations from expected flow rates are entered in the Measured Error
and Spec. Error Limit fields.
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The calculated values get saved to the database after each run which is
shown in the calibration data sheet.

19. If deviations are not within acceptable limits (It will be indicated in
RED color) you can click the Clear Fields button. If the error is greatest
at the lowest setpoint(s), re-zero the sensor. Then rerun the Check
Linearization process, using one or more checkpoints. If the deviation
are still not acceptable, make sure that the calibration conditions and
equpiment are accurate.

20. Click the Exit button to close the Linearization Calibration window.
The Linearization tab displays again, and the calibration process is
complete.
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8.6 Manual Vol-U-Meter Mode Calibration (SLA only)

8.6.1  Equipment Setup for Manual Vol-U-Meter Mode Calibration

For Manual Vol-U-Meter mode, set up the equipment as shown in
Figure 8-2.

Vol-U-Meter

1060 
Calibrator

PC running 
Brooks Service Suite

Target device 
being calibrated

Vent to desired 
pressure condition

From gas 
supply

15-pin 
D-connector 

cable
15-pin 
cable

Gas out

Gas in

Figure 8-2 Equipment Setup for Manual Vol-U-Meter Mode Calibration
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8.6.2 Performing the  Manual Vol-U-Meter Mode Calibration

You access the calibration functions from the Linearization tab.

To perform device calibration in Manual Vol-U-Meter mode:

1. In the Select Linearization tool panel, select the Manual Vol-U-Meter
option.

2. Click the Select Vol-U-Meter button.
An Open dialog box displays.
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3. Select the Tube Characterization set that you want to use for this
calibration, then click the Open button to load it.

4. Select the Vol-U-Meter tube you are going to use from the Select Tube
Number drop-down list.

In Linearization Procedure panel, there are five buttons; you are going to
go through these in sequence to perform and check the calibration. The
first step is to clear the coefficients a0 through a4 of the polynomial. This is
the polynomial of the curve that is used to linearize the mass flow sensor.

5. Click the Default Polynomials button to clear the coefficients.

A dialog box displays when clearing process is complete.

6. Click OK to dismiss the dialog box.
The polynomial coefficients are cleared.
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7. Click the Optimize Sensor button.

A dialog box explains what the Optimize Sensor process will do.

8. Click OK to start the Optimize Sensor process.  Click Default to
configure a default value of 0.81 for the Sensor Drive Setting (proceed
with numbered item 15).

In case the device type is set to Mass Flow Meter (MFM) the flow
needs to be adjusted by using an external valve. Two additional pop-
ups will appear to indicate this, adjust the flow by using the external
valve such that the ‘Flow(%)’ indicates the suggested value. A
difference between the actual and suggested flow of 1% is allowed.

9. A dialog box prompts you to determine the true flow of the target
device. Do not enter any information yet.

To execute the Optimize Sensor process, you will use the Vol-U-Meter and
1060 device to perform three flow runs at different flow rates. For each run,
you will read the time it takes for the Vol-U-Meter piston to reach a pick-off,
as shown on the 1060 display, and enter the time in the dialog box.
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The three readings will be used to: (1) make sure that the tube flows at
least to its full scale value; and (2) optimize the gain of the thermal mass
flow output.

Select a pick-off on the Vol-U-Meter that, under normal full scale flow
conditions, would require 30 seconds for the piston to reach the pick-off.

10. To start the first run, press the Start button on the Vol-U-Meter, then
press the Start button on the 1060.

Full scale flow to the Vol-U-Meter begins, and the piston starts to rise.

11. When the piston passes the pick-off, note the elapsed time for that
pick-off and the temperature on the 1060 display. In the dialog box
prompt, enter those values and select the appropriate pick-off.

12. Click OK.

The values you entered are saved, the dialog box clears, and you are
ready to start the second run.

13. Perform the second and third runs. Note that the  Vol-U-Meter time is
different for each run.

 After entering the results of the third run and clicking OK, a dialog box
displays indicating the optimization has successfully completed.

14. Click OK to dismiss the dialog box.

15. Click the Linearize Sensor button.
In case of Auto or Manual Vol-U-Meter mode you are prompted to enter
the ambient pressure.
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16. Enter the ambient pressure, then click OK.
The Linearization Calibration window displays.

By default, there are six Linearization Data Points with setpoint settings (as
percentages of full scale flow) entered. It is recommended to use the
default settings. But the desired flow can be changed to the required
values. There are 2 option buttons Default and Custom. If the values are
changed in any of the fields the Save Custom Values button will get
enabled. By clicking on this button the custom flow values can be saved.
For the next time we can use the default values or the stored custom
values by choosing the required option.
Mass Flow Meter: In case the device type is set to Mass Flow Meter
(MFM) the "Desired Flow" column is read only. The flow needs to be
adjusted using an external valve such that the "Flow%" field in the upper
right corner of the window indicates the "Desired Flow" for that row.
Mass Flow Controller: In case the device type is set to Mass Flow
Controller (MFC) the Desired Flow column represents the setpoint.
You can change the setpoint values and pick-offs used. However, make
sure you pick a flow rate and pick-off that will allow flow to continue for at
least 30 to 60 seconds before the piston rises past  the pick-off. The higher
the flow rate, the faster the piston will move, and so the higher the pick-off
that should be used. The pick-off volumes are included on the
Vol-U-Meter's data sheet, and are much more accurate than a visual
determination.
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Normally, just use defaults for Manual Vol-U-Meter mode. However, if you
are certain that your system and Vol-U-Meter have no leaks, then you
could use a higher pick-off for a lower flow rate, to compensate for any
initial flow spike.

17. To start the linearization process, click the #0 button (in the first Data
Point row) which will start a base flow measurement needed for the
linearization process. Note it's of the utmost importance that the flow is
settled to 0%. Whenever a button in the ‘Start’ column is clicked, a
window will pop up showing a decrementing 30-seconds stabilization
timer. This window will automatically close when the timer has reached
0, do not close this window because it might affect the accuracy.

18. If the base flow measurement is completed, you need to adjust the
flow ('Flow %' field in upper right corner) to the Desired Flow value by
using the external valve, in case you're calibrating a Mass Flow Meter
(MFM) using an external valve. After this, click the #1 button to start the
first flow run. In case you're calibrating a Mass Flow Controller (MFC)
you can click the #1 button immediately after completion of the base
flow measurement
After a 30-second stabilization delay, which can be stopped by the user
by clicking on the OK button in the popup

19. When the piston reaches the assigned pick-off, enter the temperature
and elapsed time shown on the 1060 display for the specified pick-off.

NOTE: You must press the Enter key after entering values in the degC and
Time fields to have the entries saved. In case you're calibrating a Mass
Flow Meter (MFM) by using an external valve, the value in the 'Desired
Flow' column will be updated with the Flow value.
20. Click the #2 button once to save the entries for the first Data Point, the
again to start the second flow run.
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Continue the flow runs, entering the temperature and elapsed time for
each run. The following screen shows an example of what the window
looks like after the final Data Point values have been entered.

When all flow runs have been completed the Calculate Polynomial
button enables.

21. Click the Calculate Polynomial button.

A dialog box indicates that the polynomial coefficients have been
stored.
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22. Click OK to dismiss the dialog box, then click the Exit button to
close the Linearization Calibration window.

The updated coefficients are displayed in Linearization tab.

In the next series of steps, you are going to check the flow for different
Data Points, but using the updated linearization polynomial. The Check
Linearization process will check the results against the expected flow rates,
and display deviation error values for each Data Point flow run.
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23. Click the Check Linearization button.

In case of Auto or Manual Vol-U-Meter mode you are prompted to enter
the ambient pressure.

24. Enter the ambient pressure, then click OK.

The Linearization Calibration window displays, but with two additional
columns of data: Measured Error and Spec. Error Limit.
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25. Optionally, you can change the setpoint setting and save them using
Save Custom Values button. The pick-off for each Data Point can also be
changed; however, it is recommended that you use the default values for
the six Data Points.
26. Adjust the flow ('Flow %' field in upper right corner) to the Desired Flow
value by using the external valve, in case you're calibrating a Mass Flow
Meter (MFM) using an external valve. After this click the #1 button to start
the first flow run. In case you're calibrating a Mass Flow Controller (MFC)
you can click the #1 button right away.
Continue the flow runs and entering the data, just as you did during the
Linearization procedure

NOTE:
When entering the flow rate, you must press the Enter key to compute the
error deviations. After pressing the Enter key but before pressing the #N
button for the next Data Point, the entry can be changed (for example, if
you accidentally entered the wrong value). However, once you press the
#N button for the next Data Point, the entries cannot be changed (unless
you press the Clear Fields button, which will clear all Data Point fields).

As you save the entered values for a Data Point, the deviations from
expected flow rates are entered in the Measured Error and Spec.
Error Limit fields.
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27. If deviations are not within acceptable limits (They are indicated in
RED color) you can click the Clear Fields button. Re-zero the sensor,
then rerun the Check Linearization process, using one or more
checkpoints. If the deviations are still not acceptable, make sure that
the calibration conditions and equipment are accurate.
If deviations are within acceptable limits, then the process can be
stopped.

28. Click the Exit button to close the Linearization Calibration window.

The Linearization tab displays again, and the calibration process is
complete.
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8.7 Reference Meter Mode Calibration

8.7.1  Equipment Setup for Reference Meter Mode Calibration

For Reference Meter mode, set up the equipment as shown in Figure 8-3.

NOTE:
A Molbloc® or a BI05 may be used in place of the reference meter
illustrated above. If using a BI05, this device should be installed
downstream of the target device.

For performing a calibration correction the setup shown above can be
used. The RS-232 port of the 48xx Series device needs to be connected to
a serial port of the PC.

Figure 8-3 Equipment Setup for Reference Meter Mode Calibration

Reference 
meter

PC running 
Brooks Service Suite

Target device 
being calibrated

Vent to desired 
pressure condition

From gas 
supply
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cable
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8.7.2 Performing the Reference Meter Mode Calibration (SLA only)

You access the calibration functions from the Linearization tab.

NOTE:
When calibrating with a reference meter and the calibration gas is different
than the process gas, it is assumed that the reference meter itself was
calibrated with the calibration gas.

To perform device calibration in Reference Meter mode:

1. In the Select Linearization tool panel, select the Reference Meter
option.

In Linearization Procedure panel, there are five buttons; you are going to
go through these in sequence to perform and check the calibration. The
first step is to clear the coefficients a0 through a4 of the polynomial. This is
the polynomial of the curve that is used to linearize the mass flow sensor.
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2. Click the Default Polynomials button to clear the coefficients.

A dialog box displays when clearing process is complete.

3. Click OK to dismiss the dialog box.
The polynomial coefficients are cleared.

4. Click the Optimize Sensor button.

A dialog box explains what the Optimize Sensor process will do.

Click OK to start the Optimize Sensor process.  Click Default to
configure a default value of 0.81 for the Sensor Drive Setting (proceed
with numbered item 15).
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5. To execute the Optimize Sensor process, you will use the reference
meter to determine the actual flow rates for three setpoints set by the
Service Suite application.

The three readings will be used to:  (1) make sure that the tube flows
at least to its full scale value; and (2) optimize the gain of the thermal
mass flow output.

In case the device type is set to Mass Flow Meter (MFM) the flow
needs to be adjusted by using an external valve. Two additional pop-
ups will appear to indicate this, adjust the flow by using the external
valve such that the ‘Flow(%)’ indicates the suggested value. A
difference between the actual and suggested flow of 1% is allowed.

After the flow stabilizes, a dialog box prompts you to enter the true flow
of the target device.
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6. Enter the flow rate detected by the reference meter, then click OK.

The entry is saved, and the flow at the second setpoint is started.
When the flow stabilizes, the dialog box prompt is displayed again.

7. Perform the second and third runs.

 After entering the results of the third run and clicking OK, a dialog box
displays indicating the optimization has successfully completed.

8. Click OK to dismiss the dialog box.

9. Click the Linearize Sensor button.
You are prompted to enter the ambient pressure.

Enter the ambient pressure, then click ENTER
The Linearization Calibration window displays.



8-38

Installation and Operation Manual
X-SW-BSS-eng

Part Number: 541B033AAG
September, 2013Brooks® Service SuiteTM

Section 8 Gas Calibration and
Reporting (Pro Version Only)

By default, there are six Linearization Data Points with setpoint settings (as
percentages of full scale flow) entered. It is recommended to use the
default settings. But the desired flow can be changed to the required
values. There are 2 option buttons Default and Custom. If the values are
changed in any of the fields the Save Custom Values button will get
enabled. By clicking on this button the custom flow values can be saved.
For the next time we can use the default values or the stored custom
values by choosing the required option.
Leave the pick-off settings at 0; they have no effect on the linearization
process.
Mass Flow Meter. In case the device type is set to Mass Flow Meter
(MFM) the Desired Flow column is read only. The flow needs to be
adjusted using an external valve such that the 'Flow %' field in the upper
right corner of the window indicates the Desired Flow for that row.
Mass Flow Controller. In case the device type is set to Mass Flow
Controller the 'Desired Flow' column represents the setpoint. You can
change the setpoint values.



8-39

Installation and Operation Manual
X-SW-BSS-eng
Part Number: 541B033AAG
September, 2013 Brooks® Service SuiteTM

Section 8 Gas Calibration and
Reporting (Pro Version Only)

10.To start the linearization process, click the #0 button (in the first Data
Point row) to start the first flow run. Whenever a button in the ‘Start’
column is clicked, a window will pop up showing a decrementing 30-
seconds stabilization timer. This window will automatically close when
the timer has reached 0, do not close this window because it might
affect the accuracy.” After the stabilization timer has expired, click the
#1 button in the ‘Start’ column and wait for the stabilization timer expiry.

11. Enter the flow rate displayed on the reference meter in the Flow field.

NOTE:
You must press the Enter key after entering values in the Flow fields to
have the entries saved. In case you're calibrating a Mass Flow Meter
(MFM) by using an external valve, the value in the 'Desired Flow' column
will be updated with the Flow value.

12. Click the #2 button to start the second flow run.

Continue the flow runs, entering the flow rate for each run. The
following screen shows an example of what the window looks like after
the final Data Point flow rate has been entered.

After having completed all flow runs, the Calculate Polynomial button
enables.
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13. Click the Calculate Polynomial button.

A dialog box indicates that the polynomial coefficients have been
stored.
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14. Click OK to dismiss the dialog box, then click the Exit button to
close the Linearization Calibration window.

The updated coefficients are displayed in Linearization tab.

In the next series of steps, you are going to check the flow for different
Data Points, but using the updated linearization polynomial. The Check
Linearization process will check the results against the expected flow rates,
and display deviation error values for each Data Point flow run.

15.Click the Check Linearization button.

The Linearization Calibration window displays, but with two additional
columns of data: Measured Error and Spec. Error Limit.
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16. You can change the setpoint setting and pick-off for each Data
Point; however, it is recommended that you use the default values for
the six Data Points.

17. Click the #1 button (in the first Data Point row) to start the first flow run.
Continue the flow runs and entering the flow rate data, just as you did
during the Linearization procedure.

NOTE:
When entering the flow rate, you must press the Enter key to compute the
error deviations. After pressing the Enter key but before pressing the #N
button for the next Data Point, the entry can be changed (for example, if
you accidentally entered the wrong value). However, once you press the
#N button for the next Data Point, the entries cannot be changed (unless
you press the Clear Fields button, which will clear all Data Point fields).

As you save the entered values for a Data Point, the deviations from
expected flow rates are entered in the Measured Error and Spec.
Error Limit fields.
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18.If deviations are not within acceptable limits, you can click the Clear
Fields button. Re-zero the sensor, then rerun the Check Linearization
process, using one or more checkpoints. If the deviations are still not
acceptable, make sure that the calibration conditions and equipment
are accurate.
If deviations are within accepatble limits, then the process can be
stopped.

19.Click the Exit button to close the Linearization Calibration window.

The Linearization tab displays again, and the calibration process is
complete.
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8.8 Saving the Calibration Data to a File

To save the gas calibration data to a device configuration text file:

1. Open the Actions menu and choose Calibration
Actions>Calibration.
The Calibration dialog box displays.

2. Go to the Save Session tab.

3. Click the Browse button.

The Save Device Configuration dialog box displays.
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4. Enter the name for the device configuration file, then click the Save
button.

You are prompted to confirm creating the file or, if you entered the
name of an existing file, to replace it.

5. To continue, click Yes.

The path and name of the device configuration file is displayed in the
Select File Name to Save field.

6. To initiate the save operation, click the Save button.

A message flashes, indicating the progress of the save operation.
When the operation is complete, the message stops flashing.

8.9 Calibration Report

The calibration report can only be shown in case the device is connected
and a session opened. In case you want to view calibration reports offline
you need to export the report to a file.

The Calibration Report summarizes product and calibration information
about the device.
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The report content includes:

• The product data, as entered on the Product Data tab on the
Calibration window.

• The calibration data, as entered on the Gas Cal. Data tab on the
Calibration window.
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• The results of the calibration linearization check procedure.

• In the Remarks section, important S-protocol data configuration
parameters.

To view the Calibration Report, select open the Actions menu and
choose Calibration Actions>Report. The Report Viewer window displays.
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From the Report Viewer, you can:
• Zoom in and out.
• Print the report.
• Save the report to one of the following file formats: PDF, Word, RTF,
Excel spreadsheet, Excel data only, or Crystal Reports (.rpt).

The calibration report can only be shown in case the device is connected
and a session opened. In case you want to view calibration reports offline
you need to export the report to a file.

To close the Report Viewer window, click the X button at the top right of
the window.

Print icon

Export to file icon

Zoom icon
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9.1 Gas Calibration Correction

The Brooks Service Suite can be used to correct a calibration record of a
48xx device. The prerequisite for this is that it contains at least one factory
calibration.

9.2 Required Conditions During Calibration

To perform calibration, the following conditions are required:
• The device has been powered on for at least 45 minutes.
• There is a supply of gas.
• During the calibration process, the device must be in a thermally stable
environment. Rapid or significant temperature changes during the
calibration process will affect the device's accuracy.

9.3 Available Calibration Methods

You can use one of the following calibration methods:
• Reference Meter Mode. The reference meter must be connected in
series with the device being calibrated. Make sure the reference meter can
measure flow at least 1.5 to 4 times the desired full scale calibration flow
amount. For a truly accurate gas calibration, the reference meter must be
substantially more accurate than the device being calibrated.

9.4 Preliminary Setup Tasks

The following topic describes the preliminary setup task that is required
prior to performing the calibration correction

9.4.1 Zeroing this Device

The Service Suite's Sensor Adjust function allows you to zero the device's
sensor when there is a no-flow condition.
To zero the device's sensor:
1.   Allow the device to be powered on for 45 minutes so that it achieves its
operating temperature.
2.  Close the downstream shutoff valve.
The device should be full of process gas with no pressure differential.
3.   Wait at least 30 seconds for the flow signal to drop to zero.
4.  Use the Service Suite's Sensor Adjust function to zero the device:
      Open the Actions menu and choose Service Actions>Tune to display
the Tuning dialog box.
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On the Sensor Adjust tab, click the Zero button. A message box displays
when the zeroing operation is complete.
The zeroing operation can take up to 10 seconds to complete.
If you attempt to zero the device using the Sensor Adjust function
while gas is flowing at 5% of full scale, a dialog box displays prompting
you to confirm whether you want to continue with the operation. This allows
you to zero the device if there is some reason for which you want to zero
the device with low flow.
If the unit cannot zero the device (for example, the device is
malfunctioning, flow is too high, or the flow oscillates), a dialog box displays
indicating that the device cannot be zeroed.

9.5 Reference Meter Mode Calibration

The Reference Meter mode calibration includes the following tasks.

9.5.1 Setting up the Equipment

For performing a calibration correction the setup shown below can be used.
The RS232 port of the 48xx Series device needs to be connected to a
serial port of the PC.
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9.6 Performing the Reference Meter Mode Calibration Correction

The calibration correction includes the following tasks, which you need to
perform in the sequence shown.

9.6.1 Selecting Destination Calibration Record and Performing Flow Runs

Selecting this menu item will lead the user through a sequence of screens
which allows performing a correction of the current selected calibration
parameters. The corrected calibration parameters will be stored in a
destination calibration record (1...9) different then the currently selected
source calibration record. Selecting the currently selected calibration record
as the destination calibration record will not be allowed.
First part of this process will be to determine the error by performing 5 flow
runs, if the error is too big (>5%) a warning will be shown and calibration
correction is discouraged.
Before selecting the Calibration Correction menu item make sure that a
valid uncorrected calibration record is selected by using the 'Control &
Monitor->Calibration Data Set' functionality. Selecting a calibration record
which was the result of a previous calibration correction action may lead to
inaccurate or failing calibration correction.
The first screen of the calibration correction shows the details of the
currently selected source calibration record.

Figure 9-1 Equipment Setup for Reference Meter Mode Calibration
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Click the 'Next' button to select the destination calibration record for storing
the corrected calibration parameters.

Click the 'Next' button to perform the flow runs.
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Start the first flow run by clicking the '#1' Start button. Wait for timer expiry
in order to give flow time to settle. Once the timer has expired, the
'Reference flow' field will become active and the percentage of full scale
flow read from the reference flow meter needs to be entered. Clicking the
'Enter' button while the focus is in the 'Reference Flow' field, will initiate a
(re)calculation of the 'Error of Rate' and 'Error of FS' values. Repeat this for
all flow runs and click the 'Next' button to initiate the background calibration
correction calculation.

9.6.2 Calibration Checking

When the background calibration correction calculation has finished
successfully, a screen will be shown to check the calibration correction.
This screen looks similar to the previous screen and works in the same
way. The 'Error of FS' field will be an indication of the accuracy of the
performed calibration correction. The Service Suite has automatically
selected the corrected destination calibration record as part of the
background calibration correction calculation. The gas information (Gas
Name, ID and Full Scale) has been copied from the source calibration
record to the destination calibration record.
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TRADEMARKS
Brooks ....................................................................... Brooks Instrument, LLC
Brooks Service Suite ................................................ Brooks Instrument, LLC
Molbloc ...................................................................................... DHI Products
Pentium................................................................................. Intel Corporation
Vol-U-Meter ............................................................... Brooks Instrument, LLC
Windows ....................................................................... Microsoft Corporation

LIMITED WARRANTY
Seller warrants that the Goods manufactured by Seller will be free from defects in materials or workmanship under normal use
and service and that the Software will execute the programming instructions provided by Seller until the expiration of the
earlier of twelve (12) months from the date of initial installation or eighteen (18) months from the date of shipment by Seller.
Products purchased by Seller from a third party for resale to Buyer (“Resale Products”) shall carry only the warranty extended
by the original manufacturer.
All replacements or repairs necessitated by inadequate preventive maintenance, or by normal wear and usage, or by fault of
Buyer, or by unsuitable power sources or by attack or deterioration under unsuitable environmental conditions, or by abuse,
accident, alteration, misuse, improper installation, modification, repair, storage or handling, or any other cause not the fault of
Seller are not covered by this limited warranty, and shall be at Buyer’s expense.
Goods repaired and parts replaced during the warranty period shall be in warranty for the remainder of the original warranty
period or ninety (90) days, whichever is longer.  This limited warranty is the only warranty made by Seller and can be
amended only in a writing signed by an authorized representative of Seller.

BROOKS SERVICE AND SUPPORT
Brooks is committed to assuring all of our customers receive the ideal flow solution for their application, along with
outstanding service and support to back it up. We operate first class repair facilities located around the world to provide
rapid response and support. Each location utilizes primary standard calibration equipment to ensure accuracy and reliability
for repairs and recalibration and is certified by our local Weights and Measures Authorities and traceable to the relevant
International Standards.
Visit www.BrooksInstrument.com to locate the service location nearest to you.

START-UP SERVICE AND IN-SITU CALIBRATION
Brooks Instrument can provide start-up service prior to operation when required.
For some process applications, where ISO-9001 Quality Certification is important, it is mandatory to verify and/or (re)calibrate
the products periodically. In many cases this service can be provided under in-situ conditions, and the results will be traceable
to the relevant international quality standards.

CUSTOMER SEMINARS AND TRAINING
Brooks Instrument can provide customer seminars and dedicated training to engineers, end users and maintenance persons.

Please contact your nearest sales representative for more details.

HELP DESK
In case you need technical assistance:

Americas  1 888 554 FLOW
Europe  +31 (0) 318 549 290
Asia  +81 (0) 3 5633 7100

Due to Brooks Instrument's commitment to continuous improvement of our products, all specifications are subject to change
without notice.


